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Getting Started 
 

Welcome 
GoToMeeting was designed to make it easier for everyone to organize and participate in online 
meetings, so you can do more and travel less. 

GoToMeeting users can collaborate on documents, deliver presentations, perform product 
demonstrations and securely share confidential information from anywhere, at any time. 
GoToMeeting’s rapid download, quick meeting setup and intuitive user interface has meeting 
organizers and attendees up and running in a matter of seconds. 

GoToMeeting incorporates industry-standard security features and end-to-end SSL encryption 
to ensure that login information and meeting data are secure. This high level of security allows 
GoToMeeting users to confidently present and collaborate on any data. Users can rest assured 
that information such as sales forecasts, financial data and M&A contracts will not be viewable 
to anyone except meeting participants. 

GoToMeeting’s All You Can Meet® pricing model provides easy-to-understand billing that helps 
you effectively budget and manage online meeting costs with no unexpected overage charges 
or additional fees. Meet as often and as long as you want for one low flat fee.  

To further increase your savings, GoToMeeting now offers an extended choice of integrated 
audio conferencing services for your online meetings at no additional cost. With the 
GoToMeeting Total Audio Service, you can choose between phone conferencing and Voice over 
Internet Protocol (VoIP) or allow both options. 
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Using This Guide 
 

Guide Structure 

This guide is divided into nine sections: 

• Getting Started – This section provides information on system requirements, useful 
terms and a product feature summary.  

• Install GoToMeeting – The section covers information on creating an organizer 
account, installing GoToMeeting, managing your GoToMeeting Preferences, and 
GoToMeeting integration.  

• Organize Meetings – This section is for GoToMeeting organizers and covers how to 
schedule, view, edit and cancel meetings. 

• Start Meetings – This section covers the multiple ways an organizer can begin a 
meeting. 

• Presenter Controls – This section is for GoToMeeting presenters and covers features 
available during a meeting like attendee management, audio, chat and drawing tools.  

• Record Meetings – This section covers how to record, play back and distribute 
meetings.  

• Attend Meetings – This section is for any GoToMeeting attendee and covers how to 
join a meeting and how to use attendee features. 

• GoToMeeting Total Audio Service – This section covers phone conferencing, VoIP, 
hardware setup recommendations and audio best practices.  

• The GoToMeeting Web Site - This section is for GoToMeeting organizers and covers 
how to access and use the GoToMeeting Organizer Web site. 

 

Individual and Corporate Users 

This user guide addresses both individual GoToMeeting users and GoToMeeting Corporate 
users. While most features apply to both audiences, some content relates to just one audience. 
To help you identify when something is just for one specific audience, this guide will clearly 
note the audience for any user-specific content. 

Feature Notes 

• Individual GoToMeeting organizers may invite up to 15 meeting attendees, for a total of 
16 people in each meeting. 

• GoToMeeting Corporate organizers may invite up to 25 meeting attendees, for a total of 
26 people in each meeting. 

 

Mac Users 

GoToMeeting users can host and attend meetings on both PCs and Mac® computers. 
Significant differences in how GoToMeeting works on the Mac platform are highlighted 
with this icon.  
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System Requirements 
For PC-based Organizers and Attendees 

• Required: Windows® 2000, XP, 2003 Server or Vista  
• Required: Internet Explorer® 6.0 or newer, or Mozilla® Firefox® 2.0 or newer 

(JavaScript™ and Java™ enabled)  

• Internet Connection Required: Cable modem, DSL, or better recommended 

• Recommended: Minimum of Pentium® class 1GHz CPU with 512 MB of RAM (2 GB of 
RAM for Windows Vista) 
 

For Mac-based Organizers and Attendees 

• Required: Mac OS® X 10.4 (Tiger®) or newer 

• Required: Safari™ 3.0 or newer, Firefox 2.0 or newer; (JavaScript and Java enabled)  

• Internet Connection Required: Cable modem, DSL, or better recommended 

• Required: PowerPC G4/G5 or Intel processor, 512 MB of RAM or better recommended 
 

To Use VoIP 

• Required: Fast Internet connection (384 kbps or more recommended) 

• Required: Microphone and speakers (USB headset recommended) 
 

For Meeting Recording 
• Required: Windows Media® Player Version 9.0 or newer  

• Required: Minimum Super VGA (800x600) or better  

• Required: Fast Internet connection(384 kbps or more recommended) 

• Required: Sound card  

• Required: Telephone attachment device (If not using Total Audio) 

• Recommended: 1.0 GB of hard disk space  

• Recommended: 1024 x 768 or higher screen resolution  

• Recommended: Minimum Pentium 800 MHz with 1.0GB of RAM for transcoding to 
Windows Media Player file format 

Recording a meeting is only available using a PC.  
 

For Instant-Messaging Integration 
• GoToMeeting integrates with the most widely used instant-messaging applications 

including: Yahoo!® Messenger™, Windows Live™ Messenger, Skype™ Chat, Microsoft® 
Communicator, Google Talk™ 

Note: Instant-Messaging Integration options are only available for use by PC-based GoToMeeting organizers. 

For Microsoft® Office® Integration 

• Microsoft Office 2002 or later 
 

For Outlook® Integration 

• Microsoft Outlook 2000 or later 
 

For Lotus Notes® Integration 

• IBM® Lotus Notes Version 6.5 or later 
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Terms 
• Organizer – An organizer has a GoToMeeting account that enables them to schedule 

and host meetings. The organizer can also grant and revoke attendee privileges like 
passing the presenter role, giving keyboard and mouse, inviting attendees and dismiss 
others. 

• Attendee – An attendee is any person who attends a meeting – including organizers, 
and presenters. By default, attendees can view the presenter's screen. An attendee 
may remotely control the presenter's computer screen if given the privilege. An 
attendee may optionally chat with other attendees, use Drawing Tools or view the 
Attendee List. 

• Presenter – A presenter is any attendee who is giving a presentation and shares his or 
her computer screen with all the attendees. The initial presenter is also the initial 
meeting organizer. The presenter also determines who gets to control the keyboard and 
mouse of the remotely viewed screen. 

• GoToMeeting Web Site – The Web site located at www.gotomeeting.com is used by 
organizers to manage their accounts and host meetings and by attendees to join 
meetings. 

• GoToMeeting System Tray Icon – The system tray icon is used by PC users to access 
organizer features of GoToMeeting and to provide status of GoToMeeting service. To 
access organizer features, right-click the system tray icon and select the desired 
feature.  

Icon Description 

 GoToMeeting is in Session – A meeting is in progress. 

 
GoToMeeting is Starting/Stopping – The application is starting up or shutting down. 
When this icon is showing, the user will not have any menu options. 

 
GoToMeeting is Connecting – The application is attempting to establish a connection 
with the server. This icon is animated to look like it is “filling up”. While connecting, 
the user has a very limited set of menu options (Help, About, Exit). 

 
GoToMeeting is Ready – A connection has been made, and the application is ready to 
be used. The user has all menu options available. 

 
GoToMeeting is Offline – A connection has been made, but there is some temporary 
network difficulty. The user will still have all menu options available. 

 
GoToMeeting is Not Connected – A connection could not be established. The user has 
a very limited set of menu options (Help, About, Exit). 

• GoToMeeting Suite Icon – The GoToMeeting Suite icon is used by Mac users to 
access organizer features. To access organizer features, double-click the GoToMeeting 
Suite icon on your desktop. 

© 2009 Citrix Online, LLC. All rights reserved.  8 
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• Account Password – An account password is what organizers use to log in to the 
GoToMeeting Web site. It must contain at least eight characters and include both letters 
and numbers. 

• Meeting Password – A meeting password is an optional value chosen by the meeting 
organizer that is used to help authenticate attendees. Requiring and specifying a 
meeting password provides enhanced privacy guarantees for the meeting by ensuring 
that only attendees that know the meeting password may join the meeting. The 
meeting password is never transmitted to Citrix Online in any form. The meeting 
password may be any alphanumeric string of one character or more the organizer would 
like such as: “7891,” “Happy Birthday,” “Citrix123,” etc. Picking a meeting password 
that is difficult to guess helps to maximize security. 

• Viewer – The Viewer is the window displayed on the attendees’ computers in which the 
presenter’s PC desktop or shared application appears. The Viewer Window has its own 
title and menu bars. 

• Presenter’s PC Image – The presenter’s PC image is the picture of the presenter’s PC 
desktop or shared application that appears to attendees in the Viewer Window. 

• Published Application – An application that is pushed to a client PC by Citrix 
Presentation Server. 

© 2009 Citrix Online, LLC. All rights reserved.  9 
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Product Features 
• Intuitive User Interface: Easy-to-understand controls enable you to start and join 

meetings in seconds without training. 

• Specific Application Sharing: PC-based presenters can select one application to 
display, so they don’t have to share their entire desktops, or worry about receiving 
distracting pop-ups from instant messages or email. 

• Screen Clean: PC-based presenters can click this option to instantly hide icons, 
wallpaper background and toolbars on their desktops, so attendees won’t be distracted 
by them. 

• Total Audio: Integrated audio service that allows you to choose between phone 
conferencing and Voice over Internet Protocol (VoIP) options for you and your 
attendees; or you can allow both options to be used in the same meeting. 

• Mac Support: Organize, present at and attend meetings from a Mac. 

• Share Keyboard and Mouse Control: Securely collaborate on documents in real time. 

• Instantly Change Presenters: Enable any participant to present to the entire group. 

• Desktop Recording and Meeting Playback: Allows PC-based presenters to record 
and play back meeting sessions to review meetings or send copies to absent colleagues 
or customers. 

• Chat Window: Chat online with any participant in the meeting. 

• Drawing Tools – Pen, Highlighter, Arrow, Spotlight: Gives attendees the ability to 
draw, highlight and point to items of interest right on the screen. Presenters have 
additional ability to use the spotlight and can erase all markings on the screen.  

• Multiple Monitor Support: Integrates GoToMeeting with multiple monitor systems, so 
users can use one for screen sharing and the other for different tasks, or share all of 
their screens.  

• Transparent Control Panel: Allows PC-based presenters to keep their Control Panel 
open on their screen while screen sharing and chatting. 

• Inactivity Time-Out: Provides added security for PC users by automatically stopping 
screen sharing after a specified period of inactivity (i.e., no keyboard or mouse 
movement). Default is 30 minutes, but setting is configurable up to one hour. 

• Integration: Easily start or join GoToMeeting sessions through various email and 
instant-messaging applications. 

• Attendee Authority: Grant and revoke attendee privileges before or during a meeting 
session. 

• Reporting: Get detailed reports for trend analysis and ROI validation. 

• True 24-Bit Color: Share presentations, graphics, pictures and PC applications with all 
meeting attendees in true 24-bit color. 

  

© 2009 Citrix Online, LLC. All rights reserved.  10 
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Install GoToMeeting 
Create Your Individual Organizer Account 
Before they can schedule or start a meeting, first-time organizers need to create their 
GoToMeeting accounts and download the GoToMeeting software. It generally takes less than 2 
minutes to set up a GoToMeeting account. 

 To create your account 

1. Go to www.gotomeeting.com and click the Try It Free button. 

2. On the Create Your Account page, enter your information and click Continue. 

3. Enter your password and click Continue. 

4. If required, enter credit card and billing information and click Get Free Trial. 

5. On the Install GoToMeeting Software page, click the Install Our Software button. 

6. If prompted, click Yes or Grant (or Trust on a Mac) to accept the download. 

 

Create Your Corporate Plan Organizer Account 
If you are a GoToMeeting Corporate user you will be invited to join by your company’s 
GoToMeeting Administrator. Before being able to schedule or start a meeting you need to 
create your GoToMeeting account and download the GoToMeeting software. 

 To create your account 

1. Go to your email application and open the GoToMeeting invitation email you received 
from your administrator entitled GoToMeeting Account Confirmation. 

2. In the email, click the Confirm Account link to create your organizer account. 

3. On the Create Account page, enter your information and click Create Account.  

4. On the Download GoToMeeting page, click the Download button.  

If prompted, click Yes, Grant or Trust to accept the download. 

 

© 2009 Citrix Online, LLC. All rights reserved.  11 
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Install GoToMeeting 
The GoToMeeting application must be installed on your computer in order for you to schedule 
and host meetings. The application will automatically download when you create your 
organizer account. 

 To install the GoToMeeting application 

1. Go to www.gotomeeting.com and log in to your account. 

2. If prompted, select Organizer. 

3. In the left navigation menu, click Host a Meeting. 

4. At the GoToMeeting Installed window, click OK. 

5. At the window Do you want to meet right now or schedule a meeting for later?, you can 
choose to start using GoToMeeting immediately or click Cancel. 

6. The GoToMeeting application is installed on your computer. For PC users, the 
GoToMeeting icon appears in your system tray and is ready for use.  

 

 

 

 

For Mac users, the GoToMeeting Suite icon appears on your desktop. Once downloaded, 
GoToMeeting can be moved from your desktop to a location of your choice, including 
your dock. 
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The GoToMeeting Application 
Many GoToMeeting functions can be accessed directly from your desktop.  

To access GoToMeeting functions directly from your PC desktop, simply right-click the  icon 
in your system tray and select the desired function.  

 Meet Now: Enables organizers to immediately start 
impromptu meetings without needing to enter meeting 
information  

 Schedule a Meeting: Enables organizers to schedule 
meetings  

 My Meetings: Provides organizers access to their 
scheduled meetings and the ability to add, edit or delete 
scheduled meetings  

 Join: Enables organizers to join meetings already in 
progress 

 Help: Launches online help  

 Preferences: Provides access to user preferences  

 About: Provides GoToMeeting software version information  

 Exit: Closes the GoToMeeting application  

Note: If your account includes GoToWebinar, additional menu options will appear. 

 

 

Mac users can access many GoToMeeting functions by double-clicking the GoToMeeting 
icon on their desktop or clicking the icon in their dock. Other functions, including Help 
and Preferences, can be accessed from the GoToMeeting menu bar.  
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Preferences – PC Users 
The GoToMeeting Preferences feature allows organizers to set preferences for running 
GoToMeeting, choose which GoToMeeting integrations are displayed and test the GoToMeeting 
connection. 

PC users can access GoToMeeting Preferences by right-clicking the  icon in the system tray, 
or if in a meeting, from the file menu. 

Note: Preference options outlined in this guide are specific to GoToMeeting. If your account includes GoToWebinar, 
additional preference options will appear. For more information on GoToWebinar preference options, please refer to the 
Getting Started section of the GoToWebinar Guide at www.gotowebinar.com/help. 

 

Mac users may access GoToMeeting Preferences by double-clicking the GoToMeeting 
Suite icon on their desktop and selecting Preferences from the GoToMeeting menu in the 
menu bar. Please see Preferences – Mac Users for more information. 

 

Start Up Preferences 

The Start Up category lets you determine how you start GoToMeeting. [new image] 

• Automatically after I log in to 
Windows – This option starts 
GoToMeeting automatically 
after you log in to your PC. 

• Manually – This option sets 
GoToMeeting to start only 
when you launch the 
application from your 
Programs Menu. 

• Remember me on this 
computer – This checkbox 
enables automatic log in to 
GoToMeeting.  

 Show me desktop 
notifications – Desktop 
Notifications deliver simple 
and effortless access to 
complimentary Citrix Online 
software upgrades, 
information, news and 
discounts individual users 
may be eligible for. 

 Remind me of upcoming meetings – This checkbox becomes available if you select 
Remember me on this computer and provides reminders for your scheduled meetings. 

 Periodically synchronize reminders with My Meetings – This option is applicable to Citrix 
Presentation Server users and is the recommended setting for optimal use. This 
checkbox becomes available if you select the Remind me of upcoming meetings 
checkbox and will synchronize meetings scheduled from a published Outlook® or Lotus 
Notes® with a local installation of GoToMeeting. 

 

© 2009 Citrix Online, LLC. All rights reserved.  14 
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General Preferences 

The General category lets you set your general GoToMeeting preferences. [new image] 

• File save settings – Enables you 
to save the Chat Log to any drive 
or directory. “Allow Citrix Online 
to store all data needed for 
reporting. Always save these to 
the local machines”. 

• Security – Set the inactivity time-
out to automatically stop screen 
sharing if there is no keyboard 
input or mouse movement for the 
specified period of time. 

• Session Identity – Remember 
your name and email as displayed 
in the attendee list.  

• Desktop notifications – This 
option enables/disables various 
system messages to appear to an 
organizer when specific meeting 
actions occur. 
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Meetings Preferences 

The Meetings category lets you determine which GoToMeeting options are available to 
attendees during a meeting. You can also select which messages are viewable during a 
meeting.  

• Enable or disable the ability 
for attendees to chat and 
view the Attendee List.  

• Create a Chat Welcome 
Message that is sent to 
each attendee upon joining 
the meeting.  

• Enable or disable various 
system messages that 
appear to you when 
specific meeting actions 
occur. 

• Select the desired color for 
your GoToMeeting Viewer 
and Control Panel. 

 
Note: If you disable the chat bubble 
option, a new message icon will appear on 
the Grab Tab to notify you of new chat 
messages as they are received.  
 

 Pink bubble designates a private chat 

 Purple bubble designates a public chat 
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Recording Preferences 

The Recording category lets you set your audio 
and video recording preferences.  

• Audio - Allows you to enable or disable the 
audio recording feature. To record, choose 
which audio service you want to use for 
your meeting (see tables below).  

• Video - Allows you to select the meeting 
recording output format and destination for 
saving the file. 

Note: Be sure to check your audio device settings 
under Audio in the left menu.  

Note: Mac users can only view meetings recorded in 
the Windows Media Player format. 

• Save in - Select the folder in which you 
want to save your recording. 

 

 

 

 
Using GoToMeeting Audio Service 

What do you want to record? Device 

Just my voice You can use either a microphone connected to your computer, or your 
telephone. 

Your computer must have a sound card installed in order to record 
audio, whether you join through the phone or VoIP. 

Everyone in the session You can use either a microphone connected to your computer, or your 
telephone.  

Your computer must have a sound card installed in order to record 
audio, whether you join through the phone or VoIP. 

 
Using Your Own Audio Service 

What do you want to record? Device 

Just my voice A microphone connected to your computer. 

Everyone in the session A phone patch connected to both your phone and the “mic in” port of 
your computer. 

Your computer must have a sound card installed in order to record 
audio. 

 

 

 

 

 



GoToMeeting User Guide 

© 2009 Citrix Online, LLC. All rights reserved.  18 

Integrations Preferences 
The Integrations category lets you determine where to display GoToMeeting integrations.  

• Use GoToMeeting with – Select 
your GoToMeeting email and 
calendar integration. By selecting 
My default email application you 
can integrate with MAPI-compliant 
email/calendar programs other 
than Microsoft Outlook and Lotus 
Notes. Depending on your email 
application's capabilities, 
integration with MAPI-enabled 
programs allows for features such 
as automatically adding meetings 
to a calendar and automatic 
creation of email messages with 
meeting information.  

• Show button in messenger 
applications – Display the 
GoToMeeting Quick Launch button 
in your selected instant-messaging 
applications.  

Note: Changes may only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application. 

 

Connection Preferences 
The Connection category allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a 
GoToMeeting Customer Care representative directs you to perform the connection test. 
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Audio Preferences 

The Audio category lets you set up and test your microphone and speakers for recording and 
for your meetings utilizing VoIP. If changes to your audio settings are made during a meeting, 
your microphone is temporarily muted so you can privately manage your settings.  

 Microphone Setup – Select a 
microphone from the drop-
down menu. To test, speak 
into your microphone; if 
connected correctly, the sound 
bar will move when you 
speak. 

 Speakers Setup – Select your 
speakers from the drop-down 
menu. To test, click Play 
Sound; if connected correctly, 
the sound bar will move and 
you will hear a short 
soundtrack. 

 Advanced - GoToMeeting 
automatically adjusts audio 
levels. We recommend you 
keep this checked. If you 
uncheck this selection, you 
must manually configure your 
audio settings through 
Windows Sounds and Audio 
Devices. If your attendees 
cannot hear you because your 
voice sounds too loud and distorted, uncheck Use microphone boost.  
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Preferences – Mac Users 
GoToMeeting Preferences allow organizers to set preferences for running GoToMeeting, choose 
which GoToMeeting integrations are displayed and test the GoToMeeting connection.  

Mac users may access GoToMeeting 
Preferences by double-clicking the 
GoToMeeting Suite icon on their desktop 
and selecting Preferences from the 
GoToMeeting menu in the menu bar.  

Note: Preference options outlined in this guide are 
specific to GoToMeeting. If your account includes 
GoToWebinar, additional preference options will 
appear. For more information on GoToWebinar 
preference options, please refer to the Getting 
Started section of the GoToWebinar Guide at 
www.gotowebinar.com/help. 

Start Up Preferences 

The Start Up tab lets you determine 
whether GoToMeeting is available immediately after startup.  

• Remember me on this computer – This checkbox enables automatic log in to 
GoToMeeting.  

General Preferences  

The General tab lets you set your general GoToMeeting preferences. 

• Session Identity – Remember your name and email as displayed in the attendee list. 

Meeting Preferences 

The Meetings tab lets you determine which GoToMeeting options are available to attendees 
during a meeting. You can also select which messages are viewable during a meeting. Options 
include: 

• Enable or disable the ability for attendees to chat and view the Attendee List.  

• Create a Chat Welcome Message that is sent to each attendee upon joining the 
meeting. 

Integrations Preferences  

The Integrations tab lets you determine where to display GoToMeeting integrations. 

By selecting My default email application you can integrate with MAPI-compliant email/calendar 
programs other than Microsoft Outlook and Lotus Notes. Depending on your email application's 
capabilities, integration with MAPI-enabled programs allows for features such as automatically 
adding meetings to a calendar and automatic creation of email messages with meeting 
information 

Connection Preferences 

The Connection tab allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a 
GoToMeeting Customer Care representative directs you to perform the connection test. 
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The GoToMeeting Outlook Toolbar 
The GoToMeeting Outlook Toolbar provides PC-
based users quick and easy access to 
GoToMeeting functions right from Microsoft 
Outlook. It includes the Meet Now and Schedule 
Meeting buttons, in addition to links to Host a 
Meeting and Join a Meeting and access to the 
My Meetings, Help and About pages.  

 

 

Note: Outlook integration requires Microsoft Outlook 2000 or later. Outlook may need to be shut down and restarted 
for the GoToMeeting Outlook bar to appear. The GoToMeeting Outlook bar can be added or removed from the 
GoToMeeting Preferences menu. Organizers using the Outlook published by Citrix Presentation Server may need to 
manually add the Outlook toolbar from the Outlook tools menu. For more details, see the Set Up GoToMeeting for Use 
with Citrix Presentation Server section of this guide. 
 
T
The GoToMeeting Lotus Notes menu options provide quick and e

he GoToMeeting Lotus Notes Menu Options  
asy access to GoToMeeting 

 

 

functions right from the IBM Lotus Notes interface. It includes the Meet Now and Schedule 
Meeting buttons, in addition to access to your My Meetings dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Lotus Notes integration requires IBM Lotus Notes 6.5 or newer. Lotus Notes may need to be shut down and 
restarted for the GoToMeeting menu options to appear. The GoToMeeting Lotus Notes menu options can be added or 
removed from the GoToMeeting Preferences menu. Organizers using Citrix Presentation Server should contact their 
Presentation Server Administrator to display or remove the GoToMeeting Lotus Notes menu options in their published 
IBM Lotus Notes. 

  

he GoToMeeting Messenger Button 
The GoToMeeting Messenger button provides a convenient way to start an impromptu meeting, 
right from your selected instant-messaging application.  

 

 

T
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Note: Please see the Software Requirements section to check what instant-messaging products and versions are 
supported. Instant-messaging applications may need to be shut down and restarted for the GoToMeeting Messenger 
button to appear. The GoToMeeting Messenger button can be added or removed from the Preferences Integrations 
category. 

 

 

 

Set Up GoToMeeting for Use with Citrix Presentation Server 
Preferences 

ng on your Presentation Server environment, your Presentation Server Administrator 
figure 
f. If your 

s chosen your configurations for you, you won’t need to do anything; if your 

Dependi
can choose to configure your GoToMeeting settings for you without notifying you; con
your settings and notify you of those settings; or allow you to configure them yoursel
Administrator ha
Administrator has configured your settings and opted to notify you, you will see a notification 
dialog when you start your first meeting from your published environment. 

 

If your Citrix Presentation Server Administrator has not already configured your GoToMeeting 
preferences, the recommended settings can be configured under the Start Up category and 
the Integrations category in the Preferences dialog. 

 

 

Recommended settings for the Start Up category: 
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1. Enable “Remind me of upcoming meetings” – This checkbox becomes available if you 
 to GoToMeeting” and will provide you with reminders for 

y 
s 

etings” – 
 

 
for optimal use. This 
checkbox becomes 

t 

1. Select your desired integration from the list of GoToMeeting integrations. 

cation listed in the Application 
s list. 

select “Automatically log in
your scheduled 
meetings. 

 

2. Enable “Periodicall
synchronize reminder
with My Me
This preference option
is applicable to users 
of Citrix Presentation 
Server and is the 
recommended setting

available if you selec
the “Remind me of 
upcoming meetings” 
checkbox and will 
synchronize meetings 
scheduled from a 
published Outlook® or Lotus Notes® with a local installation of GoToMeeting. 

 

Recommended settings for the Integrations category: 

2. Click the Advanced button and confirm that the Appli
Name field is the same as your selection from the GoToMeeting Integration
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Displaying the GoToMeeting Toolbar in Published Outlook 
ivate the 

Outlook toolbar manually in order for it to display the first time.  

y display 

ze from the Tools menu. 

3. Click to check the box next to GoToMeeting. 

. The Outlook toolbar will appear in your published Outlook on the Citrix Presentation Server. 

Organizers using Outlook published by Citrix Presentation Server may need to act

 To activate the Outlook toolbar if it doesn’t automaticall

1. Open Outlook. 

2. Select Customi

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4

 
Note: You may need to restart Outlook for the toolbar to appear.  
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 To remove the Outlook toolbar  

1. Open Outlook. 

2. Select Customize from the Tools menu. 

3. Deselect GoToMeeting from the list of toolbars. 

For more information about using GoToMeeting with Presentation Server, refer to the 
GoToMeeting for Citrix Presentation Server FAQs section at the end of this guide. 
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Organize Meetings 
 

Organizer Role Overview  

With a GoToMeeting account, an organizer can schedule and host meetings, grant and revoke 
attendee privileges like passing the presenter role and invite/dismiss attendees. 

• Organizers need to first create their accounts and download the GoToMeeting software 
on their computers before they can schedule or conduct meetings.  

• Organizers must be present at the start of any meeting as the meeting host. 

• Organizers are responsible for creating scheduled meetings or starting impromptu 
meetings.  

• Organizers invite attendees and may do so via phone, email or instant message. 

• Meetings can be started from the  icon in the PC system tray, the Mac GoToMeeting 
Suite icon, the GoToMeeting Web site, the GoToMeeting Outlook bar or the 
GoToMeeting Messenger button. 

• Once a meeting starts, the organizer becomes the meeting presenter. During the 
meeting, the organizer may pass the role of presenter to other attendees or promote 
an attendee to co-organizer. 
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Schedule a Meeting 
Organizers schedule pre-planned meetings from their desktop. 

 To schedule a meeting 

1. Right-click the  icon in the system tray on a PC or double-click the GoToMeeting Suite 
icon on a Mac and select Schedule a Meeting. 

2. Enter your Email and Password in the Login window, and click Log In.  

3. On the Schedule Meeting – GoToMeeting window, enter: 

 Subject – Enter the title of your meeting. 

 When will this meeting take place? – 
Select the date and start time. 

 Recurring meeting – Check this box to 
reuse the same meeting information for 
future meetings. 

 Audio – Select the GoToMeeting 
conference call service or provide your 
own. 

 Provide VoIP only (requires microphone 
and speakers) - All attendees join the 
audio portion via the Internet with built-in 
VoIP (Voice over Internet Protocol). 

 Provide a conference call number only - All 
attendees join the audio portion through 
the telephone. 

 Provide both - Allows all attendees to join 
the audio portion through the telephone or 
VoIP. Attendees joining through VoIP 
must have speakers to hear the meeting 
and a microphone if you would like them 
to speak. Attendees can switch between 
these audio options during a meeting. 

Note: If you are using the GoToMeeting conference call service, you can provide toll numbers for 
multiple countries. Please see the Audio Conference Options section for more information. 

 Provide your own conference call information – Select this option if you wish to use 
your company’s existing conference phone number. 

 Meeting password - If you wish to protect your meeting with a password you will be 
prompted for it when you start your meeting and/or invite additional attendees. Your 
attendees will also need to know this password to join. 

4. Click the Schedule button when complete. 

You will receive notification that your meeting has been scheduled. If you are using 
Microsoft Outlook, a meeting reminder will be generated and give you the option of 
inviting attendees via an Outlook Calendar appointment. 

Note: Your meeting is displayed in the My Meetings window until midnight following the scheduled meeting 
time. 
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Schedule an International Meeting 

As a GoToMeeting organizer you can offer your international attendees conference numbers 
specific to the country they are calling from. For example, if your attendees join from three 
different countries then you can provide three different international numbers that all access 
the same meeting. By doing this you and your attendees can avoid international rates and the 
trouble of looking up and dialing International Country Codes. To manage your default country 
preferences please see Audio Conference Options. 

Note: The GoToMeeting conference call service includes the following international coverage: Australia, Austria, 
Belgium, Denmark, France, Germany, Ireland, Italy, Netherlands, New Zealand, Norway, Spain, Sweden, Switzerland 
and United Kingdom.   

 To schedule a meeting with international conference numbers 

1. From the Schedule a Meeting window select GoToMeeting conference call service and 
then the Edit countries link. 

2. From the Edit Countries window select as many countries as necessary and click Done. 

3. Click Schedule to confirm the new meeting. 
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Schedule a Recurring Meeting 

GoToMeeting enables organizers to reuse a meeting ID for future recurring meetings without 
having to create a new meeting ID for each meeting. There are several important 
considerations to keep in mind when creating recurring meetings: 

• The recurring meeting will only appear once in the My Meetings window and the 
Organizer Web site and will be labeled “recurring.” Organizers will need to use their own 
local calendar applications to schedule and track recurring meetings. 

• The Meeting URL/ID stays available indefinitely.  

 

 

View Scheduled Meetings  

Organizers can view all scheduled meetings via the GoToMeeting application. 

 To view scheduled meetings via the GoToMeeting application 

1. Right-click the  icon in the PC 
system tray or double-click the 
GoToMeeting Suite icon on a Mac 
and select My Meetings. 

2. Enter your Email and Password in 
the Login window, and click  
Log In.  

The My Meetings window appears 
listing all scheduled meetings. 

 

Note: Scheduled meetings may also be viewed from 
the www.gotomeeting.com Web site after logging in 
to your account. 
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Invite Attendees to a Scheduled Meeting  

An organizer can invite attendees to a scheduled meeting at any time prior to the start of the 
meeting. 

Note: For information on how to invite attendees to a meeting already in progress, please see the Invite Attendees 
during a Meeting section below.  

 To invite attendees to a scheduled meeting  

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon 
on a Mac and select My Meetings. 

2. Enter your Email and Password in the Login – GoToMeeting window, and click Log In.  

3. On the My Meetings window, select the meeting you want to invite attendees to by 
clicking the name in the Subject column, and click the Invite button. 

a. If you have an email application an email will automatically be generated with 
the meeting information included in the body text, simply send the email to 
attendees. 

b. If you do not have an email application, the Meeting Scheduled window will 
appear, simply click the Show invitation text link to display the invitation 
information, click the Copy to Clipboard button and paste the invitation 
information to attendees via any desired method.  

 

Edit a Scheduled Meeting  

Meeting organizers can edit details for a scheduled meeting at any time prior to the start of the 
meeting. 

Note: Editing a scheduled meeting does not automatically update Microsoft Outlook or other calendar applications; 
neither will meeting attendees receive notice of the meeting change from GoToMeeting. Please be sure to contact 
meeting attendees directly with any changes to a scheduled meeting. 

 To edit a scheduled meeting  

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon 
on a Mac and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  

3. On the My Meetings window, select the meeting you want to edit by clicking the name 
in the Subject column and then click the Edit button. 

4. On the Edit Meeting window, make the desired changes to the meeting and click Save. 

5. Be sure to contact any previously invited attendees to notify them of the change. 
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Cancel a Scheduled Meeting 

Meeting organizers can delete a scheduled meeting at any time prior to the start of the 
meeting. 

Note: Canceling a scheduled meeting will not be automatically updated in Microsoft Outlook or other calendar 
applications; neither will meeting attendees receive notice of the cancellation from GoToMeeting. Please be sure to 
contact meeting attendees directly to notify them of the cancellation. 

 To cancel a scheduled meeting 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon 
on a Mac and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  

3. On the My Meetings window, select the meeting you want to cancel by clicking the 
name of the meeting in the Subject column and then click the Delete button. 

4. On the Meeting Deleted window, click OK to confirm deletion of meeting. 

5. Be sure to notify any previously invited attendees about the cancellation. 
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Start/End a Scheduled Meeting 
Scheduled meetings are any GoToMeeting meetings that have been previously scheduled by 
the organizer in the GoToMeeting application.  

Scheduled GoToMeeting meetings can be started from the GoToMeeting PC system tray icon, 
the Mac GoToMeeting Suite icon, the GoToMeeting Web site and the GoToMeeting Outlook bar. 

Note: To start a meeting, the GoToMeeting application must be installed on the PC or Mac being used by the meeting 
organizer. For more information on installing the GoToMeeting application please see the Getting Started section of 
this guide. 

 

Start a Scheduled Meeting from Your Desktop 

 To start a scheduled meeting from your desktop 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon 
on a Mac and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  

3. On the My Meetings window, 
select the meeting you want to 
start by selecting the name in the 
Subject column and then click the 
Start button. 

Your meeting will start and the 
GoToMeeting Organizer Control 
Panel will appear on the right s
of your desktop. For more 
information on the Organizer 
Control Panel see the 

ide 

Organizer 
Control Panel section below. 
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Start a Meeting from the Web 

 To start a scheduled meeting from the GoToMeeting Web site 

1. Log in to your organizer Web site. 

2. On the My Meetings page, locate the scheduled meeting you wish to start and click the 
Start Meeting button. 

 

3. If prompted, click Yes or Grant to accept the GoToMeeting download. 

4. Your meeting begins and the GoToMeeting Organizer Control Panel appears in the right 
side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

Start a Meeting from Outlook 

 To start a scheduled meeting from the GoToMeeting toolbar in Outlook 

1. From the GoToMeeting toolbar in 
Outlook, click the GoToMeeting 
button and select My Meetings. 

2. On the Login window, enter your Email 
and Password and click Log In. 

3. On the My Meetings window, select the 
meeting you want to start by clicking 
the name in the Subject column, and 
click the Start button. 
 
Your meeting begins and the 
GoToMeeting Organizer Control Panel 
appears in the right side of your 
desktop. See the Organizer Control 
Panel section below for more 
information. 
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Start a Meeting from IBM Lotus Notes 

 To start a scheduled meeting from the GoToMeeting IBM Lotus Notes Actions Menu  

1. From the Actions menu in the Lotus Notes toolbar, 
select My GoToMeetings.  

2. On the Login window, enter your Email address and 
Password and click Log In. 

3. On the My Meetings dialog box, select the meeting 
you want to start by clicking the name in the 
Subject column, and click the Start button. 

Your meeting will start and the GoToMeeting 
Organizer Control Panel will appear on the right side 
of your desktop. For more information on the 
Organizer Control Panel see the Organizer Control 
Panel section below. 

 

 

 

 
Start a Meeting from Microsoft Office 

 To start a scheduled meeting from the GoToMeeting Toolbar in Microsoft Office 

1. From the GoToMeeting toolbar in 
Microsoft Office, click the 
GoToMeeting button and select My 
Meetings. 

2. On the Login window, enter your Email 
address and Password and click Log In. 

3. On the My Meetings window, select the 
meeting you want to start by clicking 
the name in the Subject column, and 
click the Start button. 

Your meeting will start and the 
GoToMeeting Organizer Control Panel 
will appear in the right side of your 
desktop. For more information on the 
Organizer Control Panel see the 
Organizer Control Panel section below. 

Note: If the GoToMeeting toolbar does not appear in your Microsoft Office application, see the GoToMeeting 
Application Preferences section for instructions.  
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Start an Impromptu Meeting 
Impromptu meetings can be started by an organizer at any time without having to schedule it 
in advance. The Meet Now feature is for last-minute or on-the-fly meetings that need to occur 
without prior notice. Impromptu meetings may be initiated either from the GoToMeeting PC 
system tray icon, the Mac GoToMeeting Suite icon, from the Microsoft Outlook tool bar, the 
Lotus Notes Actions menu or from an integrated instant-messaging application.  

Note: To start a meeting, the GoToMeeting application must be installed on the PC or Mac being used by the meeting 
organizer. For more information on installing the GoToMeeting application, please see the Getting Started section of 
this guide. 

 

 To start an impromptu meeting from your desktop 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon 
on a Mac and select Meet Now. 

2. On the Login window, enter your Email and Password and click Log In. 

3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right 
side of your desktop. Conference call information appears in the meeting information 
pane of the Organizer Control Panel.  

Or 

1. Double-click the  icon in the PC system tray.  

2. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right 
side of your desktop. Conference call information appears in the meeting information 
pane of the Organizer Control Panel.  

 

 To start an impromptu meeting from the GoToMeeting Web site 

1. Go to www.gotomeeting.com and click the Host a Meeting button. 

2. If prompted, click Yes or Grant to accept the GoToMeeting download. 

3. On the Login window, enter your Email address and Password and click Log In. 

4. On the Host a Meeting window, select Meet Now. 

5. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right 
side of your desktop. Audio information appears in the meeting information pane of 
the Organizer Control Panel.  
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 To start an impromptu meeting from the GoToMeeting Toolbar in Outlook  

1. From the GoToMeeting Outlook bar, 
click the Meet Now button. 

2. On the Login window, enter your Email address and Password and click Log In. 

3. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right 
side of your desktop. Audio information appears in the meeting information pane of 
the Organizer Control Panel.  

 

To start an impromptu meeting from the GoToMeeting Toolbar in Microsoft Office 

1. From the GoToMeeting Toolbar 
in Microsoft Office, click the 
Meet now within button to launch an 
impromptu meeting. 

2. On the Login window, enter your Email address and Password and click Log In. 

3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right 
side of your desktop. 

4. Click the Show My Screen button and your presentation starts in specific application-
sharing mode. This means that GoToMeeting only displays the Microsoft Office window 
from which you started the impromptu meeting. 

Note: The GoToMeeting toolbar can be displayed in Microsoft Word, Excel and PowerPoint.  

 

 To start an impromptu meeting from the IBM Lotus Notes Actions menu 

1. From the GoToMeeting Lotus Notes 
menu options, select Meet Now with 
GoToMeeting. 

2. On the Login window, enter your Email address and 
Password and click Log In. 

3. Your meeting starts and the GoToMeeting Organizer 
Control Panel appears in the right side of your desktop. 
Audio information appears in the meeting information 
pane of the Organizer Control Panel.  
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 To start an impromptu meeting from an instant-messaging application 

1. Launch the instant-messaging application. 

2. Open a chat communication with the person you would like to invite. 

3. On the side of the chat box, click the GoToMeeting Meet Now tab. 

4. On the Login window, enter your Email address and Password and click 
Log In. 

5. Your meeting starts and the GoToMeeting Organizer Control Panel 
appears in the right side of your desktop. Audio information appears in 
the meeting information pane of the Organizer Control Panel.  

 

 

Leave or End a Meeting 
Organizers may choose to either leave a meeting while allowing the meeting to continue or to 
end a meeting completely. 

Note: If an organizer chooses to leave a meeting while allowing it to continue he or she must first designate another 
attendee as the meeting organizer. 

 To leave a meeting and allow the session to continue 

1. Prior to leaving the meeting, be sure to make another attendee the organizer. 

2. From the File menu, select Exit – Leave Meeting. 

3. On the Leave Meeting? confirmation window, click Yes. 

Note: If you leave a meeting that you organized running, you will not be allowed to host or join another meeting until 
the first meeting is finished.  

 

 To end a meeting 

1. From the File Menu, select Exit – End Meeting. 

2. On the End meeting for everyone? confirmation dialog box, click Yes. 

 

From the GoToMeeting menu on the toolbar, select Quit GoToMeeting; or select File and 
then Leave Meeting. You may also click the red X in the top left corner of the Control 
Panel and Viewer Window. 
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The Organizer/Presenter Control Panel  
When the organizer first joins the meeting the Presenter Control Panel appears on the right 
side of the desktop. The Presenter Control Panel gives 
organizers and presenters access to various organizer 
and presenter functions.  

Note: When the organizer passes the presenter role to another 
attendee, the Control Panel changes and the Screen Tools section is 
removed and given to the new presenter  

 

a • The Screen Sharing pane provides 
organizers/presenters with a visual reminder of 
On Air status, the ability to show their screens, 
pause showing their screens, pass keyboard 
control and change presenters (a) 

b 

• When selected from the Options menu, the 
Recording pane gives you the ability to record 
your meetings (b) 

c 
• The Attendee List pane provides 

organizers/presenters with a list of all meeting 
attendees and enables them to make other 
attendees organizers or presenters, grant or 
revoke attendee privileges and dismiss 
attendees (c) d 

• The Audio pane provides access to the audio 
settings for you and your attendees (d) 

• The Grab Tab enables organizers/presenters to 
minimize the Control Panel to the side of their 
desktops to display their full desktops to 
attendees and still access Presenter Screen 
Tools (e) 

e 

• The Chat pane allows organizers and attendees 
to communicate privately or publicly (f) 

• The Invite Others pane includes the meeting 
URL and ID which can be used to invite more  
attendees (g) 

 

f As a Mac presenter, your expanded Control 
Panel will be visible to attendees as a black 

silhouette and sometimes parts of the Control 
Panel are fully visible (not blacked out) to attendees. 
This can obstruct a portion of what you are presenting. 
We recommend that Mac presenters leave the Control 
Panel collapsed as much as possible during the 
meeting. If you have a multi-monitor setup, we 
recommend keeping the Control Panel on your second 
monitor. 

g 
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The Screen Sharing Pane 
When an attendee becomes a presenter, the Control Panel adjusts to incorporate the Presenter 
Screen Sharing pane at the top. The Screen Sharing pane provides the presenter with access 
to the various presentation controls. 

a

b 

c 

d e 

Presenter Screen Tools Pane 
when Screen Sharing is Off 

• The Broadcasting Status field notifies 
presenters of the status of screen 
sharing (a) 

• The Show My Screen button 
starts/pauses showing the 
presenter’s entire desktop to 
attendees (b) 

• The Screen drop-down button 
allows the presenter to share specific 
application windows, or a clean 
screen with meeting attendees (c) 

• The Give Keyboard & Mouse 
button grants shared mouse and 
keyboard control to another 
attendee (d) 

• The Change Presenter button 
passes the presenter role to another 
attendee (e) 

 

Share Your Desktop 

 To share your entire desktop 

1. Click the Screen button on the GoToMeeting Control Panel. 

2. Select the Screen option.  

 

Note: Hovering over your Show Only menu 
selection will display an animated gray 
frame which indicates what attendees will 
see if selected. If you select an application 
window that is minimized, the selected 
window will automatically maximize and be 
presented to attendees. If the presenter 
opens a window on top of the window being 
shared, screen sharing will pause until the 
intruding window is either moved or closed. 

 
Note: The specific application sharing feature will also allow you to share one or all of your multiple monitors if you  
have the hardware already set up.  

 

Note: To change the background color of a clean screen presentation, simply right-click on your desktop while you’re 
in that mode and pick from the available colors.   

Mac presenters do not have the option of displaying a clean screen or a specific 
application. We recommend you close all windows you do not want to be seen by 
attendees before beginning screen sharing. 
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Passing Roles to Attendees 

Your keyboard and mouse controls can be 
temporarily shared with one of your attendees or the 
entire group. Simply click the Give Keyboard & 
Mouse button on the Screen Sharing pane or the 
Grab Tab and then select the attendee. As the 
presenter you will always have priority control of 
your keyboard and mouse, and can regain control 
simply by hitting a key or moving your mouse. 

If you would like pass the presenter role to one of 
your attendees, simply click the Change Presenter 
button on the Screen Sharing pane or the Grab Tab 
and select the new presenter. 

To return the presenter role to yourself, click the Change Presenter button again and select 
your own name. 

 

Request Keyboard and Mouse 

Organizers and panelists can request keyboard and mouse control from the presenter. Right-
click or Control-click your name in the Attendee List pane and select Request Keyboard & 
Mouse Control.  
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Manage Attendees 
Organizers can manage attendees by right-clicking or Control-clicking attendee names in the 
Attendee List pane and selecting or deselecting the desired attendee options. 

Displays the number of 
attendees and maximum 
number of attendees for the 
meeting (a) 

 

Indicates attendee role and 
color of assigned  
Drawing Tool (b) 

Mute or unmute the  
attendee (c) 

Mute or unmute all the 
attendees (d) 
Assign your attendee the role of 
presenter and/or organizer (e) 

Share your keyboard and 
mouse with an attendee (f) 

Provide your attendee with  
on-screen drawing tools (g) 

Allow your attendee to see the 
list of other attendees (h) 

Allow your attendee to chat (i) 

Sends a chat message directly 
to the attendee (j) 

Copy the attendees email 
address to the clipboard (k) 

Dismisses an attendee from the 
meeting (l) 

 

 

 

 

c 

b 

d 
e 

g 

i 

j 
k 

a 

l 

f 
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Manage Audio  
Attendees who join the audio portion of your meeting are joined unmuted by default. 
Attendees joined via VoIP will have a microphone icon next to their name. Attendees joined via 
telephone will have a handset icon next to their name. For more information on your audio 
options, please see GoToMeeting Total Audio Service. 

Note: Organizers should be aware that attendees joining with VoIP will not be able to participate in the audio portion 
of the meeting until the meeting is started. Attendees joining by telephone can communicate with other attendees at 
any time regardless of whether or not the meeting has started. 

 

Audio PIN 

Everyone that joins a meeting is provided a unique Audio PIN which when entered offers 
additional muting and audio controls. Those joining by VoIP automatically have the Audio PIN 
assigned to them. Those joining by telephone are prompted to enter their Audio PIN when they 
first dial in. An Audio PIN can be entered on the telephone at anytime during the meeting by 
entering #, the Audio PIN and then # a second time. 

 

Attendee Audio 

a

b

 Presenter, joined via telephone but did 
not enter their Audio PIN, unmuted (a) 

 Attendee, joined via telephone,  
unmuted (b) 

 Attendee, joined via VoIP,  
unmuted (c) c

d Attendees who join the meeting via 
telephone must enter their Audio PIN so 
that you have full audio controls 
through the Organizer Control Panel. If 
not entered, you can right-click the 
person’s name and select Send Audio 
PIN. This will send a pop-up message 
with the Audio PIN to that person. (d) 

 

 

Audio Control Icons 

 

Telephone: Unmuted by default. 
Can mute/unmute self through Control Panel or telephone keypad (*6). 

 
Telephone: Muted 

 

Telephone: Did not enter Audio PIN or has not yet joined the audio portion of the meeting. 
Cannot mute/unmute attendee until Audio PIN is entered.  

 

VoIP: Unmuted by default. 
Can mute/unmute self through Control Panel. 

 
VoIP: Muted  

No 
icon 

Not connected to audio (cannot hear audio or speak). 
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Organizer Audio 

The GoToMeeting Conference Call Service allows you to manage the audio options before and 
during the meetings. If you wish to change the own connection or your attendee’s audio 
connection during a meeting, you can do so from the Audio pane of your Control Panel.  

 

Starting the Meeting 

• VoIP and Telephone: If you have selected to use 
VoIP and Telephone for your meeting, you will see 
the options Use Telephone and Use Mic & Speakers in 
your Control Panel. The default mode is Telephone; 
however, GoToMeeting will remember your selection 
for your next meeting. 

 

 

• Telephone: If you selected Telephone only for your 
meeting, you must join the audio portion by dialing 
the conference number and entering the access code 
and Audio PIN noted in the Control Panel. 

 

 

 

 To switch audio formats during a meeting  

If you are using the GoToMeeting Conference Call 
Service during a meeting, you can switch between 
using Mic & Speakers or Telephone. In the Audio pane 
at Audio Mode click either Use Telephone or Use Mic & 
Speakers. 

 

 

 

 To edit audio services for your attendees  

If you would like to provide your attendees 
different conference call options during a 
meeting, you may do so by clicking the down 
arrow in your Audio pane. 
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b 

c 

a 

Muting Audio 

With the GoToMeeting Conference Call 
Service, you can manage the muting 
and unmuting of individual attendees, 
switch audio formats and keep track 
of who is speaking.  

 

 To manage muting and 
unmuting during a meeting 

You can mute/unmute yourself 
and attendees in the following 
ways: 

• Click the microphone or 
handset icon next to the 
attendee’s name (a) 

• Click the microphone icon on 
the Grab Tab (b) 

• Click the Mute All button (c) 
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Chat with Attendees 
As an organizer you can chat with your attendees by using the built-in Chat feature in the Chat 
pane. This feature can be turned on or off from the Meetings tab in the Preferences window or 
during a meeting from the Attendee List pane.  

 

• The Chat Log displays the text 
of all public chat and chat 
between two attendees (a) 

• The Message Entry field enables 
input of chat text (b) 

• Send your chat message to All 
or a specific attendee from the 
drop-down selection field (c) 

• The Send button transmits chat 
to selected recipient(s) (d) 

• Create a Welcome message to 
be delivered to attendees when they arrive (e) 

 

Mac organizers may edit their welcome message from the File drop-down menu in the 
toolbar.  

 

a 

b 

e dc 
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Invite Attendees during a Meeting 
You as an organizer may invite new attendees to meetings in progress from the Invite Others 
pane. Invitation methods include Phone, Email and Copy/Paste.  

 

 

 

 Invite attendees by phone 

To invite attendees by phone, call the desired attendees and read them the information 
provided in the Invite Others pane. 

 

 Invite attendees by email 

To invite attendees by email, expand the Invite Others pane and then click the Email 
Invitation button.  

A new Microsoft Outlook or IBM Lotus Notes email will be generated with the meeting invitation 
information in the body of the email; simply address and send the email to the desired 
attendees. 

Note: The Email option only works with Microsoft Outlook and IBM Lotus Notes. If you have another email program 
please click the Copy Invitation button and paste the meeting information into your email service.  

 

 Copy and paste the invitation 

To invite attendees using an email service other than Microsoft Outlook, expand the Invite 
Others pane and click the Copy Invitation button. 

This will copy the meeting invitation information to your Clipboard, where it can then be pasted 
into another email program or an instant-messaging application. 
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The Control Panel Grab Tab 
The Control Panel Grab Tab enables organizers and presenters to minimize the Control Panel 
and still access Presenter Screen Tools. There are four main display modes:  

1. Organizer/Presenter has started meeting but no attendees have arrived. 

2. Attendees have arrived and the presenter is displaying his or her desktop. 

3. Attendees have arrived and the presenter has paused displaying his or her desktop. In 
this mode, screen sharing is paused and attendees see a frozen image of the 
presenter’s desktop. 

4. Attendees have arrived and the presenter has stopped displaying his or her desktop. In 
this mode, screen sharing is stopped and attendees see a “Presentation Stopped” 
message. 

 

 No Attendees 
have arrived 

Attendees 
arrived, 

presenting 
desktop  

Attendees 
arrived, 

presentation 
paused  

Attendees 
arrived, 

presentation 
stopped 

Click and drag to move Grab 
Tab up or down (a) 

Click to hide or display 
 Control Panel (b) 

Shows On Air status (c) 

The Show My Screen button 
displays desktop to attendees. 
Right-click to display multiple 

monitors, a specific application 
or a clean screen (d) 

The Stop Showing Screen 
button stops  

desktop display (e) 

The Give Keyboard & Mouse 
button grants shared 

mouse/keyboard control to 
another attendee (f) 

The Show Other’s Screen 
button passes the presenter 
role to another attendee (g) 

The Drawing Tools button 
allows the presenter to draw, 
highlight and place arrows on 
the screen, as well as use the 

spotlight and clear  
all markings (h) 

Mute or unmute yourself (i) 

 

 

 

 

 

 

 

 

 

As a Mac presenter, your expanded Control Panel and Grab Tab will be visible to attendees as a black silhouette 
and sometimes parts of the Control Panel are fully visible (not blacked out) to attendees. This can obstruct a 
portion of what you are presenting. We recommend that Mac presenters leave the Control Panel collapsed as 
much as possible during the meeting. If you have a multi-monitor setup, we recommend keeping the Control 
Panel on your second monitor. 

 

 

 

a 
b 
c 

d 

e 

f 

g 

h 

i 
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Drawing Tools  

The Drawing Tools feature is accessed from the Drawing Tool button on the GoToMeeting Grab 
Tab. Once a Drawing Tool is enabled, the Drawing Tools menu can be reselected by either 
clicking the Drawing Tools button or by right-clicking or Command-clicking your mouse. To 
deactivate a tool simply select Normal non-drawing mode from the menu.  

• No Drawing Tool selected (a) 

• Click and drag to draw on the screen 
(b) 

• Click and drag to highlight  
in yellow (c) 

• Allows the presenter to draw attention 
to an area of the screen without 
leaving a mark (d) 

• Places an arrow on the screen  
(only one arrow at a time) (e) 

• Erases all drawings (f) 

• Enables Attendee Drawing Tools during 
a meeting (g) 

 

Note: Press the Shift key with any Drawing Tool to make 
a straight line. 

Note: Only the presenter can erase drawings. Drawing 
will pause for attendees anytime the presenter pauses the 
presentation.  

 

 

The Drawing Tools feature is only 
available for meetings hosted by PC users at this time. 

f 

c 

a 

b 

d 

e 

g 
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The Organizer Menu Bar - PC 
The Organizer Control Panel menu bar provides access to various application tools not 
specifically related to managing meetings. Menu options include File, Options, View and Help.  

 

File Menu 

From the File menu, PC-based organizers can edit how their 
names and email addresses are displayed to attendees. They 

can change the meeting subject, save the chat logs of their 
meetings as .rtf files to their PCs and access Preferences 

while in session. Organizers can also exit meetings without 
ending them (they must first make another attendee an 

organizer) or exit meetings and end them. 

 
Options Menu 

From the Options menu, organizers can enable or disable the 
Attendee List and/or Chat feature for all attendees. 

 

 

View Menu 

From the View menu, organizers can record the meeting. 
Organizer can also return the Control Panel layout to its 

default settings or save the current layout. 

With Auto-Hide the Control Panel checked your Control Panel 
is set to collapse automatically after 10 seconds of inactivity. 
To disable this feature, deselect Auto-Hide the Control Panel 

in the View menu so that it is left unchecked.  

  
Help Menu 

The Help menu provides access to the online GoToMeeting 
Help file and GoToMeeting software version information. 
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The Organizer Toolbar - Mac 
 

GoToMeeting Menu 

The GoToMeeting menu allows Mac-based organizers to 
manage their preferences and end a meeting. 

  

 
File Menu 

The File menu allows organizers to edit how their names and 
email addresses are displayed to other attendees, save the 

meeting chat logs as html files and leave meetings. 

 

 

View Menu 

The View menu enables organizers to select how to display the 
Viewer Window on their desktops.  

 
Audio Menu 

The Audio menu provides organizers another option for 
managing their audio settings. They can mute themselves, 

switch between telephone and VoIP if enabled and select their 
audio input and output.  

 
Help Menu 

The Help Menu provides access to the online GoToMeeting 
Help file and to GoToMeeting software version information. 

There is also an option to leave feedback on the audio quality.  
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Record and Play a Meeting 
 

Notes on Recording and Playing a Meeting 
Meeting recording allows an organizer to record all screen activity that is presented in the 
GoToMeeting Viewer Window, including desktop and application sharing of other attendees 
presenting in the meeting. 

Meeting recording requires Windows Media Player 9.0 or higher. Windows Media Player 9.0 
currently supports, 2000, XP Home, XP Pro, 2003 Server; therefore, these are the operating 
systems required for recording with GoToMeeting.  

 The recording feature is only available to PC users at this time. 

 

To record audio, an organizer must have a sound card installed on his or her computer. (If you 
can hear music played on your computer, you have a sound card.) If you are using the 
integrated Total Audio service, the audio you and your attendees transmit over the phone or 
VoIP (using a microphone connected to your computer) will be recorded automatically when 
you click the Start Recording button.   

If you are recording a teleconference using an audio service other than Total Audio, you can 
enable the GoToMeeting Voice over Internet Protocol (VoIP) feature, position a microphone 
next to a speakerphone or set up a phone recording adapter to your phone and line-in input on 
your computer’s sound card.  

Only one recording file is created per meeting. This means that if an organizer clicks Start 
Recording to start the recording and then stops the recording and subsequently restarts the 
recording during the course of one meeting, GoToMeeting will keep recording to the same 
meeting recording file. 

The default destination location to save your recording defaults to your My Documents folder. 
You can change the destination location but only before you begin recording. It is 
recommended that the designated location have a minimum of 1.0GB of free space in order to 
accommodate the recording. For optimum recording performance and in-session experience, it 
is recommended that you select a location on your local hard drive. 
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Recording a Meeting 
The meeting recording feature is only available to meeting organizers or promoted organizers. 

 

The meeting recording feature is only available to 
PC-based meeting organizers or promoted 
organizers.  

 To configure recording settings 
1. From the Organizer Control Panel, click the View 

menu, select Recording and then click Settings.  
 

 

 

 

2. On the Recording tab:   

• Audio: Allows you to 
enable or disable the 
audio recording 
feature. To record, 
choose which audio 
service you want to 
use for your meeting.  

Note: Be sure to check your 
audio device settings under 
Audio in the left menu.  

• Video: Allows you to 
select the meeting 
recording output 
format and destination 
for saving the file.  

Note: Mac users can only 
view meetings recorded in 
Windows Media Player 
format.  

• Save in: Select the 
folder in which you 
want to save your 
recording. 

3. Click OK. 

Note: If you are using VoIP, see the VoIP 
Audio Best Practices section of this guide for 
information on testing your audio device.  

Note: For optimum recording performance and in-session 
experience, it is recommended that you select a location 
on your local hard drive. 

Note: You cannot change the input device setting or the Save in location setting once you have started to 
record a meeting. If you do not specify a destination location, the default is My Documents.  
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 To record a meeting 

1. From the Organizer Control Panel, click the 
View menu and select Recording.  

2. Click Settings in the Recording pane and 
confirm that your Audio and Video options 
are set appropriately. For detailed Audio and 
Video options, click on the Need audio help? 
link and Learn more links respectively. 

3. In the Save in: section, click the Browse 
button to identify where you would like to 
save your recording. 

4. Click OK to save your settings. 

5. In the Recording pane, click the Start Recording button to start recording. 

6. Click Show My Screen to capture the video portion of the recording. 

7. Click File and select Exit – End Meeting.  

 

Note: The lower you set your monitor resolution, the better the quality of the meeting recording. A resolution of 1024 
x 768 is recommended for optimal recording quality. Since the recording will scale to the highest resolution among the 
presenters in a recorded meeting, it is also recommended that all presenters set their resolution to the same setting. 
Avoid displaying multiple monitors when recording a meeting. 

 

Note: GoToMeeting will begin recording audio input from the time that the organizer clicks the Record button; 
however, the screen recording will not start until the presenter begins showing his or her screen. If screen sharing is 
not turned on during the course of the recorded meeting, the playback will show a black screen and play back the 
audio recording. 

 

Note: You must have at least 500 MB of space on the destination drive to record a meeting. If you have less than 500 
MB of available space, GoToMeeting will display a warning when Recording begins. If space drops to 100 MB, recording 
will be automatically stopped and you will receive a warning message. If you have selected to convert your recording 
to Windows Media format, you will need 1.0GB (twice as much space).The Remaining: field in the Recording pane 
refers to the amount of space available for recording that is listed in the Recording Preferences Save In: field. 

https://www.gotomeeting.com/default/help/g2m/g2m_user_help.htm#organizing_and_conducting_meetings/need_audio_help.htm
http://www.gotomeeting.com/default/help/g2m/g2m_user_help.htm#organizing_and_conducting_meetings/audio_learn_more.htm
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Playing a Recorded Meeting 
GoToMeeting creates one recording file per meeting. If you stop and start a recording during 
the course of a meeting, each recorded segment will be appended to the recording file in 
progress for that meeting. 

 To replay a meeting recorded in the GoToMeeting format 

1. If you haven’t already, end the meeting that you are recording and GoToMeeting will 
automatically save your file with the date and time noted after the name that you gave 
the meeting upon scheduling it. Impromptu meetings will be named with the date and 
time of the meeting followed by Meet Now. 

2. Navigate to the directory that is listed in the Save in: field under the Preferences 
Recording tab. 

3. Click the file name to start the replay.  

4. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
Window for best replay quality. 

Note: You must have GoToMeeting installed, or download the GoToMeeting codec (G2M2 decoder) to view a meeting 
recorded in the GoToMeeting format. Visit http://www.gotomeeting.com/codec to download the codec. Mac users 
cannot view meetings recorded in GoToMeeting Codec format. 
 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to 
end the meeting before playing it back. 

 To replay a meeting recorded in the Windows Media format 

1. If you haven’t already, end the meeting that you are recording. 

2. GoToMeeting will save your file with the name that you gave the meeting upon scheduling 
it, or Meet Now plus the date and time of the meeting and immediately start to convert 
the recording file into the Windows Media format. 

3. Upon completion of the conversion process, navigate to the directory that is listed as the 
Save in: field under the Preferences Recording tab. 

4. Click the file name to start the replay. 

5. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
Window for best replay quality. 

Note: The conversion process begins automatically, immediately after you end a recorded meeting in the Windows 
Media format. Allow time for the conversion to take place. The time needed is dependant upon video content, CPU 
speed and amount of memory available. Due to the use of CPU resources, you may have to wait until the conversion 
process is complete to resume use of the computer. GoToMeeting converts the recorded meeting into a Windows Media 
Player file after the meeting is over, instead of recording direct to Windows Media format, so that impact on CPU 
resources doesn’t bog down the computer during the meeting. 
 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to 
end the meeting before playing it back. 
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Distributing a Recorded Meeting 
Depending on the size, meeting recordings can be zipped and sent by email, sent by FTP or 
posted on a Web site. 

 To distribute a recorded meeting in the GoToMeeting format 

1. Deliver the recorded meeting by email or FTP or post to a Web site. 

2. Recipients must have Windows Media 9.0 or higher to view the recorded meeting. 

3. Request recipients to install the GoToMeeting Codec at 
http://www.gotomeeting.com/codec if he/she has not already installed it, or is not running 
the GoToMeeting software on his or her computer. 

 To distribute a recorded meeting in the Windows Media format 

1. Upon completion of the conversion process, deliver the recorded meeting by email or FTP 
or post to a Web site. 

2. Recipients must have Windows Media 9.0 or higher to view the recorded meeting. 

 

Troubleshooting Recording and Replaying a Meeting 

To troubleshoot recording and playback 

Please see http://www.gotomeeting.com/s/audiohelp and http://www.gotomeeting.com/s/audiolearn. These 
pages are also linked from the Recording category of the organizer Preferences menu. 
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Attending Meetings  
 

Attendee Role Overview 
A meeting attendee can be any person with an Internet connection. All that is needed to join a 
meeting is the meeting ID and, if required, the meeting password. Attendees do not need to 
subscribe to GoToMeeting; they meet at no cost to them, as guests of the organizer. 

Attendees may be given the role of organizer and/or presenter from the original meeting 
organizer at any time once a meeting has started. 

 

Join a Meeting 
There are several ways to join a meeting depending on how you receive the meeting invitation. 
Joining a meeting requires no pre-registration or configuration. 

Note: When joining a meeting, remember to also conference into the meeting using the conference call information 
provided by your meeting organizer. 

 To join a meeting from an email invitation, Outlook meeting appointment or 
instant message invitation 

1. Open the email, appointment or instant message that contains the meeting invitation. 

2. Click the link provided in the email to join the meeting. 

3. If prompted, click Yes, Grant or Trust to accept the download. 

4. If requested, enter the meeting password provided by your meeting organizer. 

5. When prompted, type in your name and optionally, your email address. 

 To join a meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 

Note: Attendees can also join meetings from www.joingotomeeting.com.  

2. In the left navigation bar click the Join a Meeting button. 

3. If prompted, click Yes, Grant or Trust to accept the download. 

4. On the Join a Meeting window, enter the Meeting ID you received from your meeting 
organizer. 

5. If requested, enter the meeting password provided by your meeting organizer. 

6. When prompted, type in your name and optionally, your email address. 

 To join a meeting from your desktop 

1. If you are also an organizer and GoToMeeting is already installed on your computer, 
you can right-click the  icon in the PC system tray or double-click the GoToMeeting 
icon on a Mac and select Join a Meeting. 

2. On the Join a Meeting window, enter the Meeting ID you received from your meeting 
organizer. 

3. If requested, enter the meeting password provided by your meeting organizer. 

4. When prompted, type in your name and optionally, your email address. 

Upon clicking OK on the Name and Email window, you enter into the meeting and the 
Attendee Control Panel and the GoToMeeting Viewer Window appear. 
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GoToMeeting Attendee Application Components 
Once attendees join a meeting they see two GoToMeeting attendee components, the 
GoToMeeting Viewer Window (a) and the GoToMeeting Attendee Control Panel (b). 

 

 

 

 

 

 

 

a b
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b 

 

e 

c 

 

The Attendee Control Panel 
When attendees first join a meeting, the Attendee Control Panel appears on the right side of 
their desktops. The Attendee Control Panel gives attendees access to various meeting 
functions. The Attendee Control Panel is comprised of four panes –Attendee List, Audio, Chat 
and Meeting Information – plus the Grab Tab. 

After approximately 10 seconds the Attendee Control Panel automatically collapses to the right 
side of the screen with only the Grab Tab displayed. The auto-collapse feature can be disabled 
from the View drop-down menu. 

The option to disable the auto-hide feature on the Control Panel is only available to 
attendees using PCs. 

 

 Attendee List Pane – If enabled by the 
organizer, provides a list of all 
meeting attendees (a) 

 Grab Tab - Enables attendees 
to minimize the Control Panel to 
the side of their desktops and still access 
Viewer tools (b) 

 Audio Pane - If the organizer 
has given attendees a choice in 
how to join the audio portion of the 
meeting, you can switch between using 
Mic & Speakers (VoIP) or 
Telephone (c) 

 Chat Pane – If enabled by the 
organizer, allows attendees to chat 
with other attendees, either individually 
or all at once, or with just the organizer 
or presenter (d) 

 Meeting Information - Provided 
for quick reference (e) 
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The Attendee Control Panel Menu Bar – PC Users 

The Attendee Control Panel menu bar provides access to various application tools not 
specifically related to attending a meeting. Menu options include File, View, Tools and Help. 

 

File Menu 

The File menu allows PC-based attendees to edit how their 
names and email addresses are displayed to other attendees, 

save the meeting chat logs as .rtf files, manage their 
preferences and exit meetings. 

From the Preferences menu, attendees can allow or forbid 
bubble messages to appear when another attendee chats or 
when GoToMeeting notifies them of system-related actions 

such as attendees joining or leaving a meeting.  

View Menu 

The View menu enables attendees to select how to display the 
Viewer Window on their desktops and how the Control Panel 

behaves when not in use. Attendees can also save a 
customized layout or return to the Control Panel to the default 

layout.  

 
Help Menu 

The Help menu provides access to the online GoToMeeting 
Help file and to GoToMeeting software version information. 

There is also an option to leave feedback on the audio quality.  
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The Attendee Toolbar – Mac Users 

 

GoToMeeting Menu 

The GoToMeeting menu allows Mac-based attendees to 
manage their Preferences and quit GoToMeeting. 

 

 

 
File Menu 

The File menu allows attendees to edit how their names and 
email addresses are displayed to other attendees, save the 

meeting chat logs as html files and leave meetings. 

 

 

View Menu 

The View menu enables attendees to select how to display the 
Viewer Window on their desktops.  

 
Audio Menu 

The Audio menu provides attendees another option for 
managing their audio settings. They can mute themselves, 

switch between telephone and VoIP if enabled and select their 
audio input and output.  

 
Help Menu 

The Help Menu provides access to the online GoToMeeting 
Help file and to GoToMeeting software version information. 

There is also an option to leave feedback on the audio quality.  
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The Attendee Control Panel Grab Tab 
The Attendee Control Panel Grab Tab enables attendees to minimize the Control Panel to the 
side of their desktops and change the way the presenter’s desktop is displayed in the Viewer 
Window. The Grab Tab changes depending on the status of the Viewer Window. 

 
 Attendee Grab Tab 

with Viewer in 
Window Mode 

Attendee 
Grab Tab with 
Viewer in Full 
Screen Mode 

Attendee Grab 
Tab with 

Drawing tools 
Enabled by 
Presenter 

Click and drag to move 
Grab Tab up or down (a) 

Click to hide or display 
Control Panel (b) 

Click the View button to 
change display modes (c) 

Click to mute or unmute 
yourself (d) 

Click and drag to move 
Grab Tab up or down (e) 

 

 

 

 

 

 

 

The Attendee Drawing Tools 
Drawing Tools must be enabled by the presenter before they appear to attendees. The 
presenter is the only one who can erase drawings. Drawing will pause when the presenter 
pauses the presentation. 

 To use a Drawing Tool 

1. Click the Drawing Tools button on the 
Attendee Grab Tab 

2. Select an appropriate tool from the Drawing 
Tools drop-down menu 

Note: Once the drawing feature is selected, you can right-click 
anywhere on the Viewer Window to change the Drawing Tool or 
return to non-drawing mode. 

 

 

 To disable a Drawing Tool 

1. Click the Drawing Tool button on the Attendee Grab Tab 

2. Select Normal non-drawing mode 

Or 

1. Right-click/Control-click anywhere on the Viewer Window  

2. Select Normal non-drawing mode from the Drawing Tools drop-down menu 

Or 

Press the Esc key to disable a drawing tool without going to the Grab Tab or Control Panel. 

 

 

a 
b 

c 

d 

e 
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Chat with Other Attendees 
If enabled by the organizer, attendees can chat with other attendees by using the built-in Chat 
feature in the Chat Pane. Or, they can just chat with the organizer or presenter. 

• The Chat Log displays the text of all 
public chat and chat between two 
attendees (a) 

• The Message Entry field enables 
input of chat text (b) 

• The Send Chat to field enables 
selection of chat recipients (c) 

• The Send button transmits chat to 
selected recipient(s) (d) 

 
 
 

 To chat with attendees 

1. Select the desired recipient(s) from the drop-down selection field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To reply to a chat 

1. Select the desired recipient(s) from the drop-down selection field. 

Or 

1. Click the Attendee’s name within the Message Entry field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To save a chat log 

1. Under the File menu, select Save Chat Log.  

2. This opens the Save Chat Log to a File window that allows you to store the file locally. 
Then browse to the location you would like to save it. 

To auto-save chat logs 

1. Click the General category on the GoToMeeting Preferences window and check Chat 
Logs. 

2. In the Save in: box, click Browse and navigate to the directory you would like to save 
the chat log under. 

3. Click OK. 

a 

b 

c d 
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The GoToMeeting Viewer Window 
The Viewer Window is where the image of the presenter’s desktop is displayed to attendees. 
The Viewer Window can be displayed in either a Window Mode or a Full Screen Mode. 

 

 To change the Viewer Window mode 

 Click the Window Mode button from 
the Grab Tab. 

Or 

 Select Window or Full Screen from the 
View menu on the Control Panel.  

 

 

In Window Mode, the 
presenter’s desktop is 
contained within a scaleable 
window. 

 

 

Full Screen Mode expands the 
presenter’s desktop completely 
over your own. The Attendee 
Control Panel/Grab Tab 
remains accessible.  
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Share Presenter Keyboard and Mouse 
At any time during a meeting, presenters may share control of their keyboard and mouse with 
any other attendee to enable that attendee to share control of applications on the desktop 
being displayed. 

When an attendee is given shared control, the GoToMeeting 
application notifies all attendees of the change in control by 
providing a System Bubble Message. 

 

 

Note: Even though an attendee may gain shared keyboard and mouse control of the presenter’s desktop, the 
presenter always retains overriding control by simply moving his or her mouse. 
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b  
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Become a Presenter 
At any time during a meeting the presenter may pass the presenter role to any other attendee 
allowing him or her to share his or her desktop screen. 

When an attendee is made a presenter the GoToMeeting application shows a dialog box 
notifying the attendee that he or she has been made presenter and updates his or her Control 
Panel and Grab Tab with Presenter Tools. 

The new PC-based presenter can click Show My Screen to present his or her entire desktop 
(a) or click the down arrow to select a specific application window (b). For more information 
about being a presenter, please see the Organizer/Presenter Control Panel section. 

 

Mac attendees can share their entire desktop but not a specific application. 

 

 

 

 
 

 

 

 
 
B
At any time during a meeting th
ecome an Organizer 

e organizer may promote any attendee to the role of co-

e 
le 

 

or more information about being an organizer, please see the Organizer/Presenter Control 

organizer to enable that attendee to share in meeting management functions. 
 

hen an attendee is promoted to the role of co-W
organizer, the GoToMeeting application notifies th
attendee of the change by providing a System Bubb
Message and updates his or her Control Panel and Grab
Tab with Organizer Tools. 
 

F
Panel section. 
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Leave a Meeting 
An attendee may leave a meeting at any time. 

 To leave a meeting from a PC 

1. From File menu on the Attendee Control Panel, select Exit – Leave Meeting. 

2. Click Yes on the Leave Meeting? window. 

 
On the GoToMeeting menu bar, click GoToMeeting and then Quit GoToMeeting; or select File 
and then Leave Meeting. You may also click the red X in the top left corner of the Control Panel 
and Viewer Window. 
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The GoToMeeting Organizer Web Site 
The GoToMeeting Organizer Web site enables organizers to view their account information, 
scheduled meetings and meeting history.  

Note: To schedule meetings, organizers need to log in to the organizer application. Please see the Organize Meetings 
section for more on scheduling meetings. 

 

Log In to the Organizer Web Site 
To access the Organizer Web site features, organizers must first log in. 

 To log in to the Organizer Web site 

1. Go to www.gotomeeting.com and click Log In from the left navigation bar. 

2. In the Returning Users section, enter your email address and password and click the 
Log In button. 

 

My Account 

The My Account page enables organizers to view and edit their personal account information, 
change passwords, set conference call preferences, view billing information and view their 
account history. 

 To edit account information 

1. Log in to the organizer Web site. 

2. In the left navigation bar, select My Account. 

3. At the top of the My Account section, enter your current password, make any desired 
account or password changes and click the Save Changes button at the bottom of the 
page. 

 

Change Account Password 

You may want to occasionally change your Account Password to improve security. If your 
account has a company administrator, he or she may require you to change your Account 
Password on a regular basis. 

 To change account password 

1. In the left navigation bar, click the My Account link. 

2. At the top of the My Account Details section, enter your current password. 

3. Enter your new password in the New Password and Re-Type New Password fields 

4. Click the Save Changes button at the bottom of the page. 

Note: Your new password must contain at least 8 characters and include both letters and numbers. 
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Audio Conference Options 

The Audio Conference Option section allows you to set your default audio preferences. If you 
select Both, your attendees will have their choice of dialing in with a provided conference call 
number or connecting with VoIP. Alternatively, you can provide your own conference call 
number(s) in this section. 

 To set Audio Conference Options 

1. In the left navigation bar, click the My Account link. 

2. At the top of the My Account Details section, enter your current password. 

3. Select the default audio service(s) you wish to include with your meetings. To provide 
local toll numbers for multiple countries, click the Add more countries link. 

4. Click the Save Changes button at the bottom of the page. Changes apply to all 
scheduled and future meetings.  
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Billing Information 

The Billing Information section enables individual GoToMeeting organizers to view and edit 
their account billing information.  

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate 
organizers. 

 To view your account billing information 

1. In the left navigation bar, click the My Account link. 

2. Click Billing Information from the expanded menu. 

3. Make any desired billing information changes and click the Save Changes button at the 
bottom of the page. 

 

 

Plan Selection 

The Plan Selection section enables individual GoToMeeting organizers to view and edit their 
GoToMeeting plan.  

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate 
organizers. 

 To purchase or change your billing plan 

1. In the left navigation bar, click the My Account link. 

2. Click Plan Selection from the expanded menu. 

3. Select a monthly or annual plan and click Continue. 

4. Enter or confirm your billing information and click Buy. 

 

 

Account History 

The billing information history section enables organizers to view the history of all activity for 
their account billing information. 

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate 
organizers. 

 To view account billing information 

1. In the left navigation bar, click the My Account link. 

2. Click Account History from the expanded menu.  
All billing activity since the account creation is displayed. 
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My Meetings 
The My Meetings section enables organizers to manage their scheduled meetings and review 
their meeting history. See Scheduling Meetings for information on creating new meetings. 

 

Scheduled Meetings  

Your scheduled meetings are first displayed when you log in to your organizer Web site but can 
also be viewed my selecting My Meetings in the left navigation bar. Meetings can be started or 
ended from this page and meetings currently in session can be joined. 

 To view scheduled meetings  

1. Log in to the organizer Web site.  

2. The My Meetings page is displayed with a list of your scheduled meetings along with 
meetings that are currently in session. The meeting subject, start date and time are 
displayed.  

 

 

Meeting History 

The Meeting History section enables individual organizers to view a report of completed 
meetings, which includes the subject, date/time, duration and number of attendees. The 
attendee names, email addresses and join/leave times can also be reviewed. 

Note: GoToMeeting Corporate organizers can view up to 12 months of meeting data. Individual GoToMeeting 
organizers can view 90 days worth of meeting data.  

 To view meeting history 

1. In the left navigation bar, click My Meetings and then Meeting History. 

2. Select the time frame and click the Show History button. 

3. Click the number in the attendee column to display attendee names, email addresses 
and join/leave times. 
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GoToMeeting Total Audio Service 
 

GoToMeeting includes an audio conference service at no extra cost to you. Choose between 
phone and Voice over Internet Protocol (VoIP) or allow both options. Participants who join the 
meeting via telephone dial a toll-based number that GoToMeeting provides automatically. 
Participants are then charged their standard long-distance rate for calling this toll-based 
number, just as if they made a regular long-distance call. Participants who join the meeting via 
VoIP need speakers or headphones to hear the GoToMeeting session and a microphone if you 
want them to speak. (We recommend a USB headset.)  

Audio details can be found in the Control Panel once the meeting starts. GoToMeeeting will 
automatically generate a conference call number, access code and Audio PIN for all attendees 
joining via telephone. 

You may decide to use the GoToMeeting Total Audio Service or choose another method of 
bringing audio to your online meetings. 

Note: If you choose to use your own audio service provider for the audio portion of the meeting, GoToMeeting will 
include your dial-in numbers with the meeting information; however GoToMeeting audio features (such as VoIP and 
Control Panel audio management) do not apply. 

 

Dialing In to the Meeting 
At the specified meeting time, dial the conference call number. When prompted, enter the 
access code followed by the # key and then your unique Audio PIN. Once in a conference call, 
participants and organizers can enter commands using their phone keypads.  

 
Commands Available to Meeting Organizers 
Command Feature Details 

*2 Count Provides the number of participants currently on the conference call. 
*3 Exit Exits the conference call. 
*4 Menu Provides a menu of available conference commands. 
*5 Listening 

Modes 
Sets listening modes for the audience. Meeting organizers can cycle 
through three listening modes by pressing *5. 
• Open conversation mode (default) 
• Mute the audience – the audience can un-mute themselves 
• Mute the audience – the audience cannot un-mute themselves 

*6 Mute/  
Unmute 

Mutes the organizer’s line. Pressing *6 again will unmute the line. 

*7 Secured/ 
Unsecured 

Secures the conference by blocking all other callers from entering. 
Pressing *7 again will open the conference again to callers. 

*8 Tone controls Sets entry and exit tones. Pressing *8 sets the options. 
• Entry and exit tones on (default)  
• Entry and exit tones off 
• Entry tone off exit tone on 
• Entry tone on exit tone off 

 
Commands Available to Participants 
Command Feature Details 

*3 Exit Exits the conference call. 
*4 Menu Provides a menu of available conference commands. 
*6 Mute/  

Unmute 
Mutes the participant’s line. Pressing *6 again will unmute the line. 
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VoIP Audio Device Recommendations 
When using VoIP for your meeting, audio quality can vary based on your audio 
software/hardware manufacturer as well as your operating system.  

 

Listed in order from best quality to poor quality 

 

USB* headset connected to your computer 

 

Headphones and USB* microphone 
connected to your computer 

Best 

 

Analog** headset connected to your 
computer 

 

Headphones and analog microphone** 
connected to your computer  

Good 

External speakers and USB microphone 

+  
External speakers and analog microphone 

Fair 

 

Laptop built-in microphone and speakers  Poor 

 

External speakers and USB Webcam 
microphone  

Poor 

*USB Cable     **Analog Cable  
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VoIP Audio Setup – PC Users 
 To select and test your Mic & Speakers settings 

1. Right-click the  icon in the PC system tray and select Preferences. 

2. Select Audio. 

• Microphone Setup - It 
is recommended that 
you test your 
microphone. To test, 
select your 
microphone device 
from the drop-down 
menu and speak into 
your microphone; if it 
is connected 
correctly, the sound 
meter will light up 
green. If the green 
meter does not light 
up, select another 
device listed in the 
drop-down menu and 
repeat this test. 

• Speakers Setup - It is 
recommended that 
you test your 
speakers. To test, 
select your speaker 
device from the drop-
down menu and click Play Sound; if connected correctly, you will see the sound 
meter light up green and hear a soundtrack through your speaker device. If you do 
not hear sound after clicking Play Sound, select another device listed in the drop-
down menu and repeat this test. 

• Advanced - GoToMeeting automatically adjusts audio levels. We recommend you 
keep this checked. If you uncheck this selection, you must manually configure your 
audio settings through Windows Sounds and Audio Devices. If your attendees can’t 
understand you because your voice is distorted, try unchecking “Microphone boost.”  

3. Click OK. 
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VoIP Audio Setup – Mac Users 
Mac users can select audio devices in-session only. GoToMeeting automatically detects the 
input and output devices connected to your computer. 

 

 To select and test your Mic & Speakers settings 

1. You can test your audio devices through the Audio pane of the Control Panel. If your 
audio devices are connected correctly, you will see the sound meters in the Control 
Panel light up green. 

2. If the meters for Mic or Speakers do not light up green when you or others are 
speaking, click the icons in the Audio pane of the Control Panel. A drop-down menu will 
appear when you click either icon.  

• Microphone: To test, speak into your microphone; if it is connected correctly, the 
sound meter will light up green. If the green meter does not light up, select another 
device listed in the drop-down menu and repeat this test. 

• Speakers: It is recommended that you test your speakers. To test, select each 
device from the drop-down menu until you will see the sound meter light up green 
and hear others speaking in the conference. If the green meter does not light up, 
select another device listed in the drop-down menu and repeat this test. 
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Optimize VoIP Audio Quality 
 

Avoiding Call Echo 

• A USB headset is recommended (see VoIP Audio Device Recommendations in this section).  

• Built-in or external speakers can cause echo. We recommend reducing the speaker volume 
to a low level. 

• Webcams with microphones can pick up additional noise and cause echo. Using a Webcam 
for your audio is not recommended. 

• Laptops with built-in microphones: Built-in microphones can pick up noise and cause echo. 
Using a built-in microphone for your audio is not recommended. If you know how to turn 
off your laptop’s built-in microphone, turn it off for your presentation (check your laptop’s 
owner manual). 

• Echo from an attendee: If you suspect echo from an attendee, check who is talking at the 
bottom of the Audio pane and mute that attendee or ask the attendee to lower his or her 
speaker volume. 

• If you join your meeting via telephone make sure the audio setting in your control panel is 
not set to User Mic & Speaker.   

• Reduce background noise (see next section). 

• See also VoIP Organizer Tips and Best Practices in this section. 

 

Avoiding Background Noise 

• A meeting is best presented from a quiet location.  

• If using a microphone, move the microphone closer to your voice and away from competing 
sounds (i.e., computer fans).  

• Avoid moving or touching the microphone during your meeting. 

• A good quality headset is recommended. Webcams and built-in microphones can pick up 
noise and are not recommended. 

 

Dropped Words, Delay, Robotic Sound 

Dropped words, delay or robotic sound is often due to poor network performance, lack of 
memory or high CPU usage.  

• Close all applications you are not using for your presentation. 

• A dial-up Internet connection can cause poor performance. For optimum performance when 
using VoIP, we recommend a broadband Internet connection. See the System 
Requirements section of this guide. 
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If No One Can Hear You 
 

Check Sound Device Settings 

• Are the correct sound devices selected in the GoToMeeting Preferences menu? See VoIP 
Audio Setup in this section. 

• If using a microphone: Does your microphone have a physical mute/unmute button on it? 
Check that your microphone is not muted.  

• If an attendee can’t hear you, his or her speaker volume may be off or set too low.  

• Analog microphones are sometimes too quiet; we recommend using a USB headset or USB 
desktop microphone instead. 

• If you are using a desktop microphone, avoid touching the microphone since it may cause a 
reduction in the volume of your voice. 

• Speaking very loudly can affect the volume; try speaking at a lower level. 

 

Internet Connection 

• The speed of your Internet connection can affect one-way sound. For optimum performance 
when using VoIP, we recommend a broadband Internet connection. See the System 
Requirements section of this guide. 

 

 

Error Messages 
An audio device (speakers or headset) is necessary to join a meeting using VoIP. When an 
audio device such as microphone or speakers is not detected, some of the following errors may 
occur: 

 

No Speakers Detected 

An error message will appear if speakers (or headset) are not present or are not connected 
properly, or if there is no sound card installed in your computer. You will not hear audio at this 
time and will not be heard in the conference. 

Check that your speakers (or headset) are properly 
connected and click Try Again in the Audio pane of 
the Control Panel. Please see VoIP Audio Setup – 
PC Users or VoIP Audio Setup – Mac Users. 

If you have the option to join the meeting via 
telephone, you will automatically be switched to 
Telephone mode. Dial in to the conference using 
the number and Audio PIN provided in the Audio 
pane of your Control Panel. 
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No Sound Detected 

After the first minute of a session, GoToMeeting looks for microphone input from attendees 
who are using a microphone, have speaking rights and are unmuted.  

If no input is detected, you may get a Trying to speak? error message. This error may appear 
under the following conditions: 

 You have not spoken or made any sound during the first minute of joining the meeting,  

or 

 The microphone device was incorrectly selected. You can click the Audio Setup link if 
you are trying to speak but can’t be heard. Please see VoIP Audio Setup – PC Users or 
VoIP Audio Setup – Mac Users. 

 

 

 

 

 

 

 

No Microphone Detected 

An error message will appear if a microphone (or 
headset) is not present or is not connected properly. 
You will still be able to hear the meeting but will not 
be able to speak. 

Check that your microphone (or headset) is properly 
plugged in. 

If you have the option to join the meeting via 
telephone, you can switch to Telephone mode. Then 
dial in to the conference using the number and Audio 
PIN provided in the Audio pane of your Control 
Panel. 

 

Virtual Operating System (VMware, Parallels, etc) 

An error message will appear if you are attempting to join a Meeting using VoIP through a 
virtualized operating system, such as VMware, Parallels, etc. In this instance, to connect to 
audio, please choose one of the following: 

• Rejoin the Meeting through a non-virtual 
operating system. 

• If you have the option to join the meeting via 
telephone, you can switch to Telephone mode. 
Then dial in to the conference using the number 
and Audio PIN provided in the Audio pane of your 
Control Panel. 
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Tips for Success 
 

Prior to Meeting Start 
• If you plan to share your entire desktop, turn off any instant-messaging applications, 

notification software or other programs that may interrupt or distract from the meeting.  

• Turn off any streaming media applications that may take up bandwidth and resource-
intensive applications that may be taxing processor ability.  

• Set the desktop display to a neutral background and adjust display settings to a mid-range 
resolution (e.g., 1024x768) to improve the display for attendees with lesser settings. This is 
also the optimal setting for recording a meeting. 

• Clean up your desktop before a meeting. Eliminate wallpaper and icons that may distract 
your attendees. 

• Have the documents you wish to share ready to be accessed in one or two clicks. 

• Run a trial meeting with a friend to anticipate questions and to familiarize yourself with the 
format of your online presentation. 

Managing the Meeting 
• Arrive a few minutes early to greet the attendees as they arrive and start the meeting on 

time. It also helps to have a welcome presentation running during this time. Your presence 
in these opening minutes can help establish the tone and direction of the meeting. 

• Create a welcome message under the Meetings category of Preferences to greet your 
attendees as they arrive at the meeting. 

• Provide an agenda at the start of the meeting, including estimated duration, and stick to it. 

• Inform attendees what the purpose/goal of the meeting is, what to expect and when and 
how to ask questions and participate in the meeting.  

• Provide information on how to use equipment or services and how to get assistance if 
needed. 

• Nominate a co-organizer to monitor and respond to the chat log when someone is 
presenting. 

• Encourage participation by using open questions such as “What would you suggest?” and 
“How do you feel about…?” 

• End the meeting clearly. Make sure all the attendees know that the meeting is formally over 
and stay on the line to address any last questions. 

Managing the Conference Call 

• Call in to the meeting from a location where there is little background noise. 

• Consider globally muting participants at the start of the meeting to avoid noise issues. Turn 
off system prompts and sounds for when attendees join or leave a meeting. 

• Avoid using cellular and cordless phones because of static and use the phone handset or a 
headset instead of speakerphones because of background noise, tunnel effect and sentence 
clipping. 

• Turn off your call waiting. The beep of a new call on another line is heard by everyone on 
the teleconference. 

• Avoid putting your phone on hold during a teleconference. Your hold music will play into the 
conference call, and make it impossible for the other attendees to continue the meeting. 

• Introduce yourself when you begin speaking and ask other attendees to also identify 
themselves before speaking. Not everyone in the meeting may know everyone else’s voice. 

• If you find you are having a sound quality issue, hang up and dial back in. Sometimes these 
problems clear themselves up when the bad connection is terminated. 
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FAQs 
 

General FAQs 
I never received my meeting organizer invitation email. What should I do? 

Sometimes the meeting organizer invitation email will get blocked by your email server as 
spam. If you do not have the ability to check email in a spam folder, check with your 
Administrator to see if the invitation can be resent. Otherwise, ask your administrator to 
contact the account manager for help. 

 

How can I see what future meetings I have scheduled? 

To see what meetings you have scheduled, right-click the  icon in the system tray or double-
click the GoToMeeting Suite icon on a Mac and select My Meetings. After your login email 
address is verified, you will see the list of scheduled meetings. 

Likewise, you can log in to www.gotomeeting.com and view your scheduled meetings. 

 

I forgot my password. What should I do? 

First make sure you are entering your correct login email address and password – note that 
your password is case sensitive and must contain at least 8 characters and include numbers 
and letters.  

If you still need to reset your password, just visit 
https://www.gotomeeting.com/en_US/forgotpassword/forgotPassword.tmpl and enter your 
email address. You can also reach this page via the www.gotomeeting.com login page. An 
email will automatically be sent to your login email address to reset your password. 

 

How long will my past meetings appear in my Meeting History? 

Past meetings will appear in your Meeting History for 90 days, after which they will be deleted 
from the system. If you would like to keep records of your meetings for auditing purposes, 
have your administrator run a Meeting History report at least once every 90 days. 

 

Why does the meeting pause when I open a window that I am not sharing? 

The application sharing feature is set up to ensure that you are only sharing the specific 
window that you have selected. If you inadvertently open a different window, GoToMeeting will 
automatically pause the meeting to protect your privacy. Screen sharing will resume once you 
have moved or closed the obstructing window. The Specific Application Sharing feature is only 
available to PC users.  

 

What happens when I stop showing my screen? What do my attendees see? 

When you click the Stop button, screen sharing will be turned off and you will no longer 
transmit your desktop contents to your attendees. Instead, your attendees will see the Waiting 
Room screen until you click the Play button to resume screen sharing. GoToMeeting Corporate 
users can ask their account manager to upload a company logo to display on the Waiting Room 
screen. 
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How do I share one application and nothing else? 

A presenter can share a single application by right-clicking the screen-sharing icon on the 
Control Panel Grab Tab and then selecting the application to share from the list of applications 
presented. The application sharing feature is only available to PC users.  

 

After I've given keyboard and mouse control away, how do I get it back? 

As a security feature, you can regain control of your desktop/laptop by simply moving your 
mouse. The change of control happens almost instantaneously. At any time you can revoke an 
attendee’s shared control of your mouse and keyboard if you want to prevent him or her from 
regaining control. 

 

Are there any files or folders left on an attendee’s computer after the session ends? 

Some downloaded files do remain after a meeting so that the attendee may join future 
meetings more quickly (without having to download all the files again). However, the files are 
inactive, will not consume system resources, do not compromise security and perform no 
functions until the attendee joins another meeting and the files are engaged by a new meeting 
ID. If desired, an attendee may uninstall all GoToMeeting files using the Add/Remove 
Programs feature in the Windows control panel. 

 

Why would I make someone else an organizer in my meeting? 

If you created a meeting and needed to leave, but wanted your attendees to continue the 
discussion, you would want to make someone else the organizer. The meeting would proceed 
without you without interruption. Or, if you wanted to have a co-organizer to monitor and 
respond to attendee chat questions while you focused on the task of presenting.  

 

Is there a charge for using the integrated conference call service or VoIP?  

GoToMeeting is packaged with both VoIP and a phone conferencing service at no extra cost to 
you. You may decide to use one or both of these services or choose another method of 
bringing audio to your online meetings. Our phone conference service provides a toll-based 
number that is dialed by all meeting participants. Participants are then charged their 
standard long-distance rate for calling this toll-based number, just as if they made a 
regular long-distance call. There is no additional charge for the conferencing feature. If 
attendees wish avoid incurring long-distance charges then they can join the meeting with VoIP.  

 

How do I save chat sessions from my meetings?  

Under the File menu, select Save Chat Log. This opens the Save Chat Log to a File window that 
allows you to store the file locally. Alternately, if you are using a PC, under the General 
category of your GoToMeeting Preferences, you can check the box marked Chat Logs to 
automatically save your chat logs to your local computer after each meeting. 
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Do you offer training for GoToMeeting? 

Yes, please see the Instructor Led Training and Video Tutorials sections of the GoToMeeting 
help file for more information. 

 

Is there a log of who has attended my meetings? How can I view information about 
past attendees? 

Sign in to www.gotomeeting.com with your email address and password. Select My Meetings 
from the menu options on the left. Select sub menu, Meeting History.  

The information is grouped by month. You can see your meetings in chronological order. Each 
meeting contains the number of attendees, shown in blue. Click this number, and a window 
opens listing the attendees’ first and last names, their email addresses and their join/leave 
times. This information can be copied into another document.   

 

Are Mac or Linux operating systems supported by GoToMeeting? 

Currently Linux operating systems are not supported by GoToMeeting, either to host or join a 
meeting. However, GoToMeeting does support Mac-based organizers and attendees. 

 

As a Mac presenter, is my GoToMeeting Control Panel visible to my attendees? 

Yes, if you are a Mac presenter, your expanded Control Panel will be visible to attendees as a 
black silhouette and sometimes parts of the Control Panel are fully visible (not blacked out) to 
attendees. This can obstruct a portion of what you are presenting. We recommend that Mac 
presenters leave the Control Panel collapsed as much as possible during the meeting. If you 
have a multi-monitor setup, we recommend keeping the Control Panel on your second monitor. 

 

Is audio streaming supported in GoToMeeting? 

Yes, online audio, or VoIP, is an alternative to dialing in with a conference phone number.  
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Is video streaming supported in GoToMeeting? 

While we do not yet support streaming video, our GoToMeeting technology is fast enough to 
keep up with screen changes on the desktop, so it appears as if it is streaming video.  
Because more data is being sent to all meeting attendees, bandwidth usage will go up for all 
meeting participants. The amount will depend on the resolution and length of the video. 
Also, certain versions of Windows Media Player with DirectX (Microsoft DirectX is an advanced 
suite of multimedia application programming interfaces (APIs) built into Microsoft Windows 
operating systems), will not display the video. 
To enable video display for your meetings, you need to disable Hardware Overlay for your player. 
Please see your media player’s help section for directions on how to disable Hardware Overlay. 

 
Why am I having trouble sharing specific applications during a meeting? 

If you are using a multi-monitor enhancement application like UltraMon™ or ObjectDock™ 
software that adds a button to each window you may experience difficulties sharing specific 
applications. Try to disable the window buttons in these types of applications to resolve the 
issue.  
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Recording FAQs 
Why can't I record? 

In order to record a meeting, you must use a PC and have Windows Media Player 9 or above. 
You can download this for free at 
http://www.microsoft.com/windows/windowsmedia/default.aspx.  
  
Can meeting attendees record a meeting using the GoToMeeting recording feature? 

No, only PC-based meeting organizers or promoted organizers have access to the GoToMeeting 
recording feature. 

  

How do I record a meeting with audio? 

To record audio, an organizer must have a sound card installed on his or her computer. (If you 
can hear music played on your computer, you have a sound card.) If you are using the 
integrated Total Audio service, the audio you and your attendees transmit over the phone or 
VoIP (using a microphone connected to your computer) will be recorded automatically when 
you click the Start Recording button.   

If you are recording a teleconference using an audio service other than Total Audio, you can 
position the microphone next to the phone or set up a phone-recording adapter to your phone 
and line-in input on your computer’s sound card. In addition, be sure that the Record Audio 
option is selected from the Recording category in your GoToMeeting Preferences.  

 

How can I improve the quality of my meeting recordings? 

The lower you set your monitor resolution, the better the quality of the meeting recording. We 
recommend a maximum resolution of 1024x768 for optimal recording quality. 

  

What happens if I click the Stop button in the recording pane in the middle of a 
meeting recording and then resume recording? 

The meeting recording stops when you click the Stop button in the Recording pane and 
resumes recording when you click the Start Recording button. However, a new file is not 
created for each recorded segment of the meeting; it is simply appended to the existing 
recording file. You will only have one recording file per meeting. 

  

What happens if one of the presenters on my recorded meeting has a larger screen 
than I do? 

The recording will have the dimensions of the largest screen presented during the meeting. 
The portions of a recorded meeting that show a smaller screen will display the image centered 
in the playback window with a black border around it.  
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How do I save my meeting recording? 

Recordings are automatically saved to the path indicated under the Recording category in your 
GoToMeeting Preferences when you end or leave a meeting. Meet Now meetings will be named 
with the date and time plus the words “Meet Now,” while Scheduled Meetings will include the 
meeting subject in the file name. Note that you cannot change the location where you would 
like to save a recording once you have clicked the Start Recording button. If you cannot find 
your recording, check the path listed in the Save in pane of your Recording Preferences. 

 

Where are my recorded meetings stored? 

The default destination for recorded meetings is the My Documents folder. You can change the 
destination location only before recording begins. It is recommended that the designated 
location have a minimum of 1.0GB of free space to accommodate the recording. 

 

How do I play back a recorded meeting? 
First you must end the meeting that you are recording. GoToMeeting will then automatically 
save your file with the meeting name you designated at the time of scheduling as well as the 
date and time. Impromptu meetings will be named with the date and time of the meeting 
followed by “Meet Now.” 

1. Navigate to the directory that is listed in the Save in: field under the Recording 
Preferences category. 

2. Click the file name to start the replay.  

3. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
Window for best replay quality. 

*To view a meeting recorded in the GoToMeeting format, you must either have GoToMeeting 
installed, or download the GoToMeeting codec (GoToMeeting 2.0 decoder) at 
http://www.gotomeeting.com/codec.  

**To view a meeting recorded in the Windows Media format, you will have to wait until the 
conversion process is complete. GoToMeeting converts the recorded meeting into a Windows 
Media Player file after the meeting is over so that the impact on CPU resources doesn’t bog 
down the computer during the meeting. Allow time for the conversion to take place. The time 
needed is dependant upon video content, CPU speed and amount of memory available. 

***Playing a recorded meeting back before ending the meeting may cause abnormal playback 
behavior. Be sure to end the meeting before playing it back. 

 

When I play a recorded meeting, it plays back scrambled. Is there something I can 
do to fix this? 

If you experience scrambled playback of a meeting recording, which can happen if the 
presenter used a multiple monitor setup, you can try the following: 

In Windows Media Player, go to the Tools menu and select Options. Click Advanced under the 
Performance tab. In the dialog that pops up, uncheck “use video mixing renderer”. Click OK 
until you have dismissed all dialogs. Play the video again, and it should play unscrambled. 

 

Can I edit a recorded meeting?  

GoToMeeting Desktop Recording and Playback allows you to record and preserve meetings as 
they actually occurred. You can use the editing software of your choice to edit those files.  
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What is the best way to distribute a recorded meeting? 

If a meeting recording is small enough, you can distribute it as an email attachment. However, 
most recorded meetings will be too large for emailing. If this is the case, you may want to 
upload the file to a Web server for easy access. Remember that Mac-based viewers can only 
view meetings in the Windows Media Player format and that PC-based viewers must have 
GoToMeeting or the GoToMeeting 2.0 Video Codec installed to watch a recorded meeting 
created in the GoToMeeting format. The GoToMeeting 2.0 Video Codec is available to download 
for free at: http://www.gotomeeting.com/codec and can be distributed freely. Regardless of 
the format, all viewers must have Windows Media Player 9 or higher to view the recording. 

 

 

GoToMeeting for Citrix Presentation Server FAQs 
Organizer FAQs 

Once I start a meeting, it runs on my local desktop. When I try to invite other 
attendees using the “By email” option on the Organizer Control Panel, GoToMeeting 
doesn’t integrate with my published version of Outlook. How can I resolve this? 

You need to verify that the option that is selected in your GoToMeeting Preferences under the 
Integrations category matches the option that is selected in the Advanced section of the 
Integrations.  

 

Attendee FAQs 

When I am designated the presenter at a meeting, I can only show the applications 
that are published to me from Presentation Server and nothing that is on my local 
desktop. How can I present my local desktop? 

Contact your Citrix Presentation Server Administrator about installing GoToMeeting on 
Presentation Server. By installing GoToMeeting and configuring the recommended settings on 
Presentation Server, all GoToMeeting sessions will be redirected to the desktop. Running a 
meeting on the local desktop allows you to present everything on your desktop, if you choose. 
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Contact Support 
 
If you are experiencing problems with GoToMeeting or have questions, please contact: 

• Customer support: gotomeetingcare@citrixonline.com 

• Billing or account questions to: accounts@citrixonline.com 

• Feedback or comments: https://www.gotomeeting.com/en_US/pre/feedback.tmpl 

 

Country Toll-Free Direct Dial 

U.S. and Canada 800-263-6317 805-617-7000 

United Kingdom 0800-404-9279 001-805-617-7000 

Europe 00-800-7770-0011 001-805-617-7000 

Australia 0011-800-7770-0011 00111-805-617-7000 

Mexico 001-888-840-6244 001-805-617-7000 

India 000-800-100-3359 001-805-617-7000 

New Zealand 00-800-7770-0011 001-805-617-7000 

*Toll-free service unavailable in some areas 
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